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Introduction 
 
 
 
Ce guide est destiné aux étudiants des filières biologie, chimie-biologie et biologie-terre univers 
environnement qui suivent le module d'informatique INF112.  
 
Le but de cet enseignement est de développer une certaine culture informatique, qui consiste à mieux 
connaître le fonctionnement de l'ordinateur, et d'en faire une utilisation plus raisonnée et plus efficace, allant 
au-dela de la simple démarche "Savoir où cliquer pour obtenir un résultat particulier". Une telle démarche 
implique que l'on réapprenne tout à chaque mise à jour de logiciel, or le matériel et les logiciels évoluent vite 
et ont une courte durée de vie. Il est donc plus utile de connaître les principes de fonctionnement, qui 
évoluent moins vite : en effet, le concept de l'ordinateur moderne que nous utilisons aujourd'hui a été décrit 
dès ... 1945, dans un rapport de Herman Hollerith. 
  
"Savoir où cliquer" ne constitue donc pas un but en soi, mais est une étape nécessaire dans l'utilisation d'un 
ordinateur. Les chapitres 1 à 10, qui décrivent l'environnement et les différents logiciels utilisés au DLST, 
ont été rédigés pour vous permettre de perdre le moins de temps possible en tâtonnements dans cette étape. Il 
s'agit donc d'une référence à consulter chaque fois qu'une question se pose sur le fonctionnement d'un 
logiciel particulier. 
 
Les langages de l'informatique sont moins éphémères que les logiciels et leur connaissance, même 
superficielle, contribue à une meilleure compréhension des rouages de l'ordinateur et donc à une meilleure 
utilisation de celui-ci. Ils permettent également la réalisation des oeuvres les plus variées, et dont on ne 
connaît pas encore aujourd'hui les limites. Les grandes oeuvres informatiques n'étant cependant pas (encore) 
au programme de cet enseignement, nous nous contenterons d'une première approche de quelques langages 
parmi les plus accessibles. Cette sélection de langages est résumée dans les chapitres 11 à 13. Là encore, il 
s'agit d'une référence à consulter. Ces langages et leur utilisation seront plus amplement développés en cours. 
 
 
 
 
 
Bonne navigation avec le INF112 ! 
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1 Environnement de travail 
1.1 Introduction 
Au cours de cette année, la plupart des TPs auront lieu sur un PC (PC = Personnal Computer = ordinateur 
Personnel). 
Un ordinateur est constitué d’un clavier, d’un écran, d’une souris et d’un boîtier gris qui contient le cœur de 
l’ordinateur (un processeur, de la mémoire, des lecteurs CD et/ou disquette). 
On appelle « périphériques », l’ensemble des éléments physiques permettant de communiquer avec le 
processeur. 
 
Pour faire fonctionner un ordinateur, on utilise un programme particulier appelé « Système d’exploitation ». 
Sans système d’exploitation, un ordinateur ne peut pas être utilisé. Il existe plusieurs types de systèmes 
d’exploitations : MacOS, Linux, Unix, Dos/Windows.  
Les ordinateurs PC que nous utiliserons cette année sont équipés d’un système d’exploitation Dos/Windows 
XP. 
 
Windows XP est un système d’exploitation permettant de faire fonctionner un réseau d’ordinateurs et de 
partager des informations sur ce réseau. Ainsi, un étudiant peut travailler sur un PC en salle A103 et 
récupérer son travail sur un autre PC (dans la salle B106, par exemple).  
 
Pour pouvoir travailler dans cet environnement, une personne doit avoir un « compte informatique ». Un 
compte est identifié par un nom (login) et un mot de passe. Un compte informatique est créé pour chaque 
étudiant à son inscription. Le Login et le mot de passe peuvent être récupérés sur les bornes du DLST (dont 
une se situe en salle de lecture). Le login et le mot de passe peuvent aussi se récupérer sur une page web dont 
l’adresse peut vous être donnée par votre enseignant. Vous devez vous munir de votre carte étudiant pour 
récupérer ces informations. 
 
Ensuite, une personne doit se connecter sur l’ordinateur (en anglais « to log in », en franglais, « se loger » 
prononcez « se loguer »). L’opération de connexion aboutit à l’ouverture d’une « session de travail ». 

1.2 Se connecter 
Sur l’écran, vous pouvez voir le message « Appuyer sur Ctrl+Alt+Suppr pour ouvrir une session ». Il 
faut maintenir appuyées les touches « Ctrl » et « Alt » puis appuyer sur la touche « Suppr » (voir la section 
1.4 si vous ne trouvez pas ces touches). Une fenêtre d’avertissement s’ouvre. Lisez et cliquez sur OK. 
 
Une autre fenêtre s’ouvre. Elle a pour titre "Informations de session". Vous devez écrire votre login 
utilisateur et votre mot de passe1 dans les "champs" correspondants. Assurez-vous que le domaine est bien 
"E". Sinon, modifiez le en utilisant le menu déroulant associé au champ "Domaine". Cliquez sur OK. 
Si un message d’erreur apparaît,.attendez que l’écran de démarrage réapparaisse (il doit être identique à 
l’écran que vous aviez en arrivant) et recommencez. 
 
Pour des raisons de confidentialité, le mot de passe n'apparaît pas à l'écran. Chaque touche est représentée 
par une étoile.  
Respectez les majuscules, minuscules et caractères spéciaux :  

1) une lettre minuscule n'est pas équivalente à sa correspondante majuscule : f différent de F.  
Ne pas confondre le i majuscule (caractère I) qui ressemble au L minuscule (caractère l) et au un 

numérique (caractère 1), le o majuscule (caractère O) avec le zéro (caractère 0). 
2) pour les chiffres de la zone alpha-numérique du clavier et les caractères de ponctuation, le  
verrouillage majuscule (cadenas) n'est pas équivalent à la touche majuscule (×). 

 

                                                      
1 Vous devez TOUJOURS vous munir de ces informations pour venir en informatique. Attention, ces informations sont 
PERSONNELLE et CONFIDENTIELLES 
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1.3 Déconnexion 
Avant de partir, n’oubliez JAMAIS de vous déconnecter. Si vous oubliez, des personnes mal intentionnées 
pourraient utiliser votre compte informatique pour effectuer des manipulations illégales dont vous seriez 
tenus RESPONSABLES devant la commission de discipline.  
Pour vous déconnecter :  
• Cliquez sur le menu Démarrer et sélectionnez l’action Arrêter 
• Cliquez sur Fermer toutes les applications et ouvrir une session sous un nom différent 
• Vérifiez que l’ordinateur affiche bien l’écran d’accueil initial avant de partir. 
 

1.4 Le clavier  

 
Clavier AZERTY 

 
La plupart des touches permettent de taper des lettres et/ou des chiffres. Certaines touches ne font rien à elles 
seules (×, Ctrl, Alt, Alt Gr : touches de contrôle), ou ont des fonctions particulières (touches de verrouillage, 
d’effacement, etc …)  
 
Les touches de contrôle : 
Combinées avec les touches alpha-numériques (caractères figurant en haut des touches : lettres et chiffres), 
les touches × (majuscule), Ctrl, Alt, Alt Gr permettent d’accéder à des jeux de caractères différents : 
majuscules, chiffres du pavé alpha-numérique, caractères étrangers ou particuliers. Pour taper un de ces 
caractères particuliers, maintenez la touche de contrôle enfoncée, et taper le caractère choisi. 
Exemple :  

pour taper A (a majuscule) : maintenez enfoncé × et appuyez sur la touche A, 
pour taper ñ (n tilde) : maintenez enfoncé Alt Gr et appuyez sur la touche 2 du pavé alpha-
numérique (au dessus du A et du Z) puis taper n minuscule.  

De manière générale on utilise la touche × pour activer le caractère bas (ou bas et gauche) des touches du 
clavier et la touche Alt Gr pour les caractères bas de droite. 
Certaines de ces touches de contrôle se retrouvent de part et d’autre du clavier (comme la touche ×).  
Les touches Alt et Alt Gr n’ont pas les mêmes fonctions. 
 
Les touches de verrouillage : « Caps Lock », « Num Lock » 
Elles mettent tout ou partie du clavier dans un mode particulier, et sont associées à un voyant lumineux en 
haut à droite du clavier indiquant si elles sont activées ou non. Une première pression sur la touche active le 
mode choisi (voyant allumé), une deuxième pression le désactive : 
« Caps Lock » (cadenas) : Cette touche affectant les lettres du pavé alpha-numérique permet d’écrire en 
majuscule. 
« Num Lock » (Verr Num): Cette touche affectant le pavé numérique permet d’accéder aux fonctions de ce 
pavé. Lorsque la touche est activée (voyant allumé) ce sont les valeurs numériques qui seront validées, 
lorsque la touche est inactivée (voyant éteint) ce sont les déplacements dans le texte qui seront validés (cf. § 
« Les touches utiles pour les déplacements dans le texte » page suivante). 
Les touches utiles pour la saisie de texte : 
 « Ins » (Inser) : affecte le mode d’insertion des caractères tapés. Par défaut, les caractères insérés au milieu 
d’un texte provoquent le décalage du texte à droite du point d’insertion. Cette touche permet de basculer vers 
un mode où les caractères tapés au milieu d’un texte remplacent les caractères à droite du point d’insertion. 
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On s’aperçoit en général de l’existence de cette fonction lorsqu’on l’a accidentellement activée … pour 
revenir au mode normal, simplement ré-appuyer sur la touche « Ins » 
Í (à droite de la ligne de touches « chiffres et lettres ») : touche d’effacement du caractère à gauche du 
curseur texte. 
« Suppr » : touches d’effacement du caractère à droite du curseur texte. 
 
Les touches utiles pour les déplacements dans le texte  : 
Ñ: touche de déplacement en début de ligne. 
« Fin » : touche de déplacement en fin de ligne. 
PgUP (à droite de Ñ) et PgDN (à droite de « Fin ») : touches de déplacement par bloc plus haut ou plus bas 
dans la page. 
ÏÍÐÎ : déplacement du curseur d’un caractère respectivement vers le haut, la gauche, le bas et la droite. 
On remarquera que ces mêmes fonctions peuvent être activées par les touches du pavé numérique non activé 
(« NumLock » voyant éteint, cf § « Les touches de verrouillage » page précédente ). 
 
Les touches de caractères de mise en forme de texte : 
Entrée (grande touche à droite du pavé alpha-numérique, ou touche « Entr » du pavé numérique) :  
 Dans un texte : retour à la ligne. 
 Dans une commande : valide et exécute la commande. 
Espace tabulation (« Tab », en haut à gauche du clavier, à gauche du A) : espace blanc de longueur 
paramétrable par mise en place de taquets de tabulation (cf § 3.4.7 « Mise en place de tabulation »). 

1.5 Session Windows XP 

1.5.1 Bureau et barre des tâches 
L’ouverture d’une session donne accès à un espace de travail qui comporte deux parties :  

• un fond d’écran vert par défaut (le bureau) 
• une barre grise en bas de l’écran. Cette barre s’appelle la « barre des tâches »  

 
 

Sur le bureau, en-dehors de la barre des tâches, il y a plusieurs petits « dessins ». Ces dessins, appelés 
« icônes », correspondent à des programmes (ou logiciels). 

1.5.2 Démarrer un programme (Word, Excel, PowerPoint, 
Internet Explorer,…) 

Il y a deux manières de procéder : 
(1) 
• Dans la barre des tâches, cliquez sur le bouton Démarrer (un menu 

déroulant apparaît) 
• Cliquez sur le sous-menu Tous les programmes 
• Cliquez sur le programme souhaité dans la liste qui apparaît. 
 
 
 
 
(2) 
• Sur le bureau, repérez l’icône correspondant au programme souhaité  
• Double-cliquez dessus. 
 
Remarque : tous les logiciels disponibles sur l’ordinateur apparaissent dans le sous-menu Programmes, 
mais seuls les plus couramment utilisés ont une icône sur le bureau. 
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1.5.3 L’interface de fenêtres 
Lorsque on démarre un programme tel que Word, une fenêtre (window en anglais) apparaît à l’écran. C’est 
par cette interface que l’utilisateur (c’est-à-dire vous) communique avec ce programme. 
Une fenêtre peut être déplacée, redimensionnée, ou mise en attente dans la barre des tâches. Ces opérations 
servent à organiser l’écran pour travailler confortablement. 
 
Plusieurs fenêtres peuvent être ouvertes simultanément, mais une seulement sera active : celle dont la barre 
de titre apparaît en couleur, et qui apparaît au premier plan. Les fenêtres inactives sont parfois cachées par la 
fenêtre active, mais lorsqu’elles sont visibles elles présentent une barre de titre en grisé. Pour activer une 
fenêtre il suffit de cliquer dans la fenêtre désirée. Les différentes fenêtres potentiellement activables à un 
instant donné peuvent être activées par l’intermédiaire du menu « Fenêtre » présent dans tous les logiciels. 
 
La plupart des logiciels sur PC présentent des interfaces similaires dont les caractéristiques sont rappelées 
sur la figure suivante :  
 
 
 
 
 
 
 
 
 
 

 
 
 
  
 
Il y a 3 menus essentiels que l’on retrouve sur tous les logiciels, avec parfois des variations dans la 
présentation. Ce sont : 
• Le menu « Fichier » qui comporte les commandes d’ouverture, de création et d’enregistrement de 

fichier. Ces commandes primordiales seront détaillées dans les chapitres consacrés à chacun des logiciels 
utilisés. 

• Le menu « Edition » qui comporte notamment les commandes « Annuler », « Couper », « Copier » et 
« Coller » 

• Le menu « ? » (Aide), toujours placé à droite des autres menus. 
 

Bouton de mise en attente 
en barre des tâches 

Bouton de 
fermeture de 
fenêtre

Enregistrer 

Nouveau document 

Barre de titre 
Barre des menus 

Barre d’outils 

Règle

Bouton 
d’agrandissement/restauration 

Ouvrir 

Barre d’outils Barre d’état 
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1.5.4 La commande « annuler » 
Cette commande permet d’annuler la dernière action effectuée. Dans de nombreux logiciels (Word, …) elle 
se comporte même comme une « pile » enregistrant toutes les modifications effectuées depuis le dernier 
enregistrement, ce qui permet si besoin d’annuler, une par une, toutes ces opérations.  
 

1.5.5 Copier-coller, couper-coller. 
Cet outil commun à la plupart des logiciels permet, dans un document particulier, d’introduire des données 
provenant d’un autre emplacement dans le fichier, voire d’un autre fichier, et éventuellement produites avec 
un logiciel différent. Par exemple, un graphique Excel dans un document Word. Le mode d’emploi du 
Copier-coller est le suivant : 
 
 (1) l’élément à copier ne change pas de fichier: 
• Sélectionnez l’élément à copier 
• menu Edition → Copier  
• Placez le curseur à l’endroit voulu pour la copie.  
• menu Edition → Coller 
 
(2) Le fichier cible est différent du fichier source, mais tous deux sont issus du même logiciel : 
• Ouvrez les 2 fichiers 
• Dans le fichier source, sélectionnez l’élément à copier dans le fichier  
• menu Edition → Copier  
• Passez de la fenêtre du fichier source à la fenêtre du fichier cible : Fenêtre → Nom du fichier cible 
• Dans le fichier cible, placez le curseur à l’endroit voulu pour la copie.  
• menu Edition → Coller 
 
(3) Les fichiers cible et source sont différents, et issus de logiciels différents : 
• Ouvrez les 2 fichiers 
• Dans le fichier source, sélectionnez l’élément à copier dans le fichier  
• menu Edition → Copier  
• Activez le logiciel du fichier cible en cliquant sur son bouton dans la barre des tâches en bas de l’écran 

(et si besoin sa fenêtre par : Fenêtre → Nom du fichier cible) 
• Dans le fichier cible, placez le curseur à l’endroit voulu pour la copie.  
• menu Edition → Coller 
 
La démarche à suivre pour faire un « Couper-coller » est identique. Dans ce cas, l’élément n’est pas dupliqué 
mais déplacé. 
 
Les commandes Copier, Couper et Coller du menu Edition sont également 
accessibles : 
• par le menu flottant contextuel qui apparaît par clic du bouton droit sur la 

sélection reproduit ci-contre. 
• par les raccourcis claviers : « CTRL » + « C », « CTRL » + « X », et 

« CTRL » + « V » respectivement. 
 
Remarque : 
Les objets (textes, images, etc …) copiés ou collés sont provisoirement stockés dans une zone mémoire 
normalement invisible, appelée le « Presse-papier ».  

1.5.6 Aide en ligne : menu ? 
Cette aide permet d’obtenir des renseignements sur le fonctionnement de tous les éléments de chaque 
logiciel, et en particulier : 
• Obtenir des détails sur une commande particulière, 
• Trouver les commandes à activer pour faire une manipulation particulière. 
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Le menu « Aide » de Word 

 
 
 
La rubrique « Aide sur 
Microsoft Word » 

 

                 La rubrique « Sommaire et index » : 

 
 
 
 
 
 
 
 
 
Dans la suite de ce document sera détaillée une partie des fonctionnalités des logiciels que vous serez 
amenés à utiliser au cours de cet enseignement. Ces logiciels sont les suivants : 
 

Explorateur Windows Gestion des mémoires de masse 
Word Traitement de texte 
Power Point Logiciel de dessin et de réalisation de diaporama 
Excel Tableur et grapheur 
Internet Explorer Butineur (afficheur de page web) 
Bloc-notes Editeur de texte sans mise en forme (éditeur ASCII) 
WebExpert Editeur spécialisé de page web 
Gimp Editeur spécialisé d’images 
WS_FTP LE Logiciel de transfert de fichiers d'un ordinateur à un autre 
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2 Explorateur Windows 
 
Explorateur Windows est un logiciel qui permet d’avoir une vue d’ensemble sur tous les répertoires 
(ou dossiers2) et fichiers (ou documents) créés, ainsi que sur tous les lecteurs disponibles des 
mémoires de masse. Il permet en outre de créer la hiérarchie des répertoires désirée ou de retrouver 
un fichier égaré, et également de connaître les spécificités de chaque fichier telles que : le type, la 
taille, la date de dernière modification, le propriétaire, les droits d’accès.  
 

2.1 Lancer le programme : 
Il y a 3 manières de procéder : 
1 - Démarrer -> Programmes -> Accessoires -> 
Explorateur Windows 
2 – Maintenir enfoncée la touche  et appuyez sur la 
touche E 

3 - Cliquez sur l’icône  du bureau (si elle est 
présente). 

 

Une fenêtre s’ouvre avec l’affichage de tous les répertoires dans la partie gauche, et dans la partie droite 
l’affichage du contenu du répertoire actif, c’est à dire le répertoire sélectionné dans la partie gauche. Par 
exemple, sur la figure précédente, le répertoire actif est « home sur sarado (Z:) »  
Le nom du répertoire actif et son chemin (cf § 2.2) apparaît au-dessus de la partie droite. 
 
Le seul espace disque qui vous est réservé est « home sur sarado  (Z :)». Tous les autres endroits sont 
régulièrement effacés par la maintenance, et ce, sans préavis. Il faut donc toujours sauvegarder les 
informations sur le serveur commun qui porte le nom « home sur sarado  (Z :)» 
 
Pour allez sur le lecteur Z: cliquer sur le signe plus associé «Poste de travail», la liste de l’ensemble des 
mémoires de masse disponibles se déroule alors. Cliquez l’icône de «home sur Sarado (Z:)» : le contenu 
de votre répertoire de travail doit apparaître dans la partie droite de la fenêtre de l’explorateur. Les 
répertoires sont matérialisés sous la forme de dossier ( ), les fichiers par une icône dépendant de leur 
type (exemple icône pour un fichier HTML : ). 
 

2.2 Lors de la première utilisation :  
configurez l’Explorateur Windows de la façon suivante afin d’obtenir les 
modalités de fonctionnement qui vous seront demandées lors des TP : 
• Cliquez sur le menu Outils de l’Explorateur Windows 
• Cliquez sur le sous-menu Options des dossiers… 
• Dans l’onglet Affichage cochez l’option l’option Afficher le chemin 

d’accès complet dans la barre de titre 
 
• Décochez l’option Masquez les extensions pour les types de fichiers 

connus 
 

 

2.3 Copier un fichier 
• Faire apparaître dans la partie droite de l’Explorateur Windows le fichier à copier (par exemple :  

exemple.txt) 

                                                      
2 Les fichiers sont organisés (rangés) dans des dossiers, sortes de boîtes qui peuvent s’imbriquer les unes 
dans les autres. On parle aussi de répertoires ou de directory. 
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• Cliquez sur l’icône représentant ce fichier avec le bouton droit de la souris 
• Un menu flottant et contextuel apparaît, cliquez sur "Copier" 
• Utilisez dans la partie gauche de l’Explorateur Windows les symboles « plus » associés aux différents 

niveaux de répertoires jusqu’à faire apparaître le répertoire qui doit recevoir la copie du fichier 
précédemment copié.  

• Cliquez sur l’icône correspondant à ce répertoire avec le bouton gauche de la souris, la liste du contenu 
de ce répertoire apparaît dans la partie droite de l’Explorateur Windows. 

• Cliquez avec le bouton droit de la souris dans une partie vide de cette partie droite de l’Explorateur 
Windows, un menu flottant apparaît, cliquez sur "Coller" 

• Une nouvelle icône apparaît. Elle porte le même nom que le fichier d’origine. 
Remarque : lorsque la copie de fichier est réalisée dans le même répertoire, le nouveau fichier est alors 
nommé : Copie de exemple.txt 
 

2.4 Changer le nom d’un fichier ou d’un dossier 
• Cliquez sur l’icône représentant le fichier avec le bouton gauche de la souris 
• Cliquez sur le nom du fichier avec le bouton gauche de la souris, le nom du fichier apparaît alors en 

inverse vidéo (caractère en blanc sur fond noir) dans un cadre et le curseur de souris change de forme (il 
passe de la forme flèche à la forme curseur de texte : barre verticale). Cela signifie que l’ordinateur est 
prêt à recevoir la modification du nom du fichier par une saisie de texte. Tapez tout de suite le nouveau 
nom de fichier, l’effacement de l’ancien nom est automatique. 

• Lorsque c’est terminé, appuyez sur la touche "Entrée" du clavier (ou sur le bouton droit de la souris en 
dehors de la zone de nom de fichier). Le cadre autour du nom du fichier disparaît et le curseur de la 
souris reprend sa forme. 

La procédure est la même pour changer le nom d’un dossier. 
 

2.5 Créer un nouveau dossier 
Il y a deux manières de procéder : 
(1) 
• Déroulez le menu "Fichier" de l’Explorateur Windows 
• Cliquez sur "Nouveau", puis sur "Dossier" 
• Vous êtes directement en situation de pouvoir nommer le dossier comme vous le souhaitez (cf. § 2.4 

« Changer le nom d’un fichier ou d’un dossier ») 
(2) 
• Activez dans la partie gauche de l’Explorateur Windows le répertoire père du répertoire que vous désirez 

créer (c’est-à-dire le répertoire existant qui va contenir le nouveau répertoire). 
• Dans la partie droite de l’Explorateur Windows, cliquez sur le bouton droit de la souris et choisissez, 

dans le menu flottant contextuel qui apparaît, la commande « Nouveau » puis « Dossier ». 
• Vous êtes directement en situation de pouvoir nommer le dossier comme vous le souhaitez (cf. 2.4 § 

« Changer le nom d’un fichier ou d’un dossier ») 
 

2.6 Déplacer un fichier exemple.txt dans un dossier Machin : 
• Faire apparaître le fichier exemple.txt ans la partie droite de l’Explorateur Windows. 
• Rechercher dans la partie gauche de l’Explorateur Windows, en n’utilisant que les symboles « plus », le 

dossier Machin dans lequel vous voulez ranger le fichier exemple.txt. Attention : ne pas activer de 
répertoire, cela changerait le contenu de la partie droite de l’Explorateur Windows. 

• Cliquez sur le fichier exemple.txt, toujours présent la partie droite de l’Explorateur Windows, avec le 
bouton gauche de la souris et maintenez appuyé. 

• Faites glisser le curseur de la souris jusqu’à le superposer avec le dossier Machin dans la partie gauche 
de l’Explorateur Windows. 
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2.7 Effacer un fichier ou un dossier  
Pour effacer un fichier : 
• Sélectionnez le dossier de manière à faire apparaître le fichier dans la partie droite de l’Explorateur 

Windows, puis cliquez sur le fichier avec le bouton droit 
• Dans le menu flottant contextuel qui apparaît, choisissez "Supprimer" 
• Le fichier supprimé va alors se ranger dans la « Corbeille » qu’il faut penser à vider régulièrement. 
La procédure est la même pour effacer un dossier, à cela près que le dossier peut se trouver indifféremment 
dans la partie droite ou gauche de l’Explorateur Windows. 
 

2.8 Connaître les spécificités d’un fichier ou d’un dossier 
Les fichiers et les répertoires possèdent un certain nombre de propriétés, par exemple le logiciel qui les a 
créé, mais aussi : 
• La taille (nombre d’octets qu’il occupe sur le disque) 
• La date de création, la date de dernière modification 
• L’auteur du fichier, ou la personne qui l’a créé 
Les droits d’accès : qui peut lire ou modifier le fichier lorsque celui-ci est copié dans un répertoire 
commun ? 
 
Démarche à suivre : 

• Cliquez sur l’icône représentant le fichier exemple.txt avec 
le bouton droit de la souris 

• Un menu flottant apparaît, cliquez sur "Propriétés" 
• La boîte de dialogue ci-contre apparaît qui vous permet de 

consulter les spécificités du fichier ou dossier concerné. 
 
Suivant la version de Windows installée et le type de fichier 
sélectionné, plusieurs onglets sont disponibles. 
 
L’onglet « Général » est toujours présent et donne des 
renseignements sur les droits en lecture du fichier : si la case 
lecture seule est activée, seul le propriétaire du fichier pourra le 
modifier. Vous pouvez par exemple modifier les droits en 
lecture de vos fichiers pour que les autres binômes ne puissent 
pas avoir accès à votre travail. 

L’onglet « Sécurité » permet quant à lui de modifier l’appartenance et les permissions, c’est-à-dire qu’on 
pourra autoriser ou non les personnes choisies à lire, écrire et exécuter le fichier. Il peut y avoir également 
les onglets « Statistiques », « Personnalisation », « Contenu », « Résumé » … , qui donnent d’autres 
renseignements généraux et qui permettent de se faire une idée du contenu du fichier sans avoir besoin de 
l’ouvrir. 
 
Une autre propriété intéressante que l’on peut noter avec l’explorateur Windows est la nature des dossiers 
que l’on crée pour ranger les fichiers. Si l’on examine la taille d’un dossier, on se rend compte que celui-ci 
n’a pas de taille propre mais que la taille indiquée n’est que la somme des fichiers qu’il contient. Cela 
signifie que le dossier n’occupe aucun espace sur le disque, c’est juste un système de rangement.   

 



UJF Licence Sciences – INF 112 Guide  

16 

3 Word 
 
Word est un type de programme appelé « traitement de textes ». Il permet par exemple de composer 
des lettres ou des rapports et de leur donner une présentation soignée (mise en forme), de les 
sauvegarder puis de les imprimer. 
 
Version utilisée au DLST : Microsoft Word 97 (dans deux salles uniquement). L’alternative Open-Office 
présente des fonctionnalités similaires (mis à part les macros telles que nous les utiliserons), est présent dans 
toutes les salles. 
 

3.1 Démarrage et interface générale 
 
Pour lancer Word : Démarrer → Tous les programmes → Microsoft Word 
Ou bien cliquez sur l’icône du bureau (si elle est présente) : 

 
 
A l’ouverture du logiciel une fenêtre « Microsoft Word » similaire3 à celle du dessin ci-dessous apparaît. 
Elle comporte une zone de commandes, qui a été détaillée dans le § 1.5.3, et une zone d’édition qui est 
l’endroit où le texte que vous tapez et mettez en forma va apparaître. 
 

 
la fenêtre d’interface du logiciel « Word ». 

 
Pour pouvoir écrire dans une fenêtre déterminée il faut que celle-ci soit active, c'est-à-dire que le curseur de 
la souris apparaisse à l'intérieur de celle-ci (cf § 1.5.3 « l’interface de fenêtre »).  
Lors de la saisie d’un texte il ne faut pas taper de retour à la ligne quand vous atteignez la marge à droite de 
la fenêtre, le texte se déroulera automatiquement à la ligne suivante. On parle de saisie de texte « au km ». 
Dès que vous avez saisi du texte, il est primordial de le sauvegarder (enregistrer) régulièrement afin de ne 
pas perdre l’information.  
 
 

                                                      
3 Dans le cas ou la fenêtre qui vous apparaît est différente de celle donnée dans la figure 3.1 par le fait qu’il 
lui manque une barre d’icônes par exemple, sachez qu’il vous est possible de paramétrer vos fenêtres de 
travail. Pour ce faire, allez dans le menu Affichage puis déplacez-vous sur la commande Barre d’outils, et 
faites vos choix dans la liste qui se déroule alors. 
S’il vous arrive de perdre votre barre de menu, ce n’est pas ordinaire, Quittez (menu Fichier) puis relancez 
le logiciel. 
 

Zone d’édition 
du texte 
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3.2 Opérations sur les fichiers : 

3.2.1 Sauvegarder un document en première sauvegarde 
• Dans le menu Fichier, cliquez sur le bouton Enregistrer sous… , vous obtenez par défaut la fenêtre 

suivante : 
 

Enregistrer dans : 

Dossier parent 

Cr�er un dossier 

 
la boîte de dialogue « Enregistrer sous …» 

 
• La zone Enregistrer dans permet de choisir le lecteur et le répertoire de rangement. Par défaut, vous 

vous trouvez dans le dossier Personnel, créé dans Crip (C :)  
 
Ne jamais sauvegarder sur le disque dur interne de votre PC, appelé « Crip (C :) ».  
Le seul espace disque qui vous est réservé est « home sur sarado  (Z :)». Tous les autres endroits sont 
régulièrement effacés par la maintenance, et ce, sans préavis. Il faut donc toujours sauvegarder les 
informations sur le serveur commun qui porte le nom « home sur sarado  (Z :)» 
 
• Cliquez sur le triangle noir pointant vers le bas (flèche) de la zone « Enregistrer dans » : et cliquez sur 

home sur « sarado » (Z :). Le bouton Dossier parent permet de remonter au niveau supérieur dans 
l’arborescence (passer du sous-répertoire courant au répertoire parent, par exemple). 

• Sélectionnez le répertoire souhaité dont le nom doit apparaître finalement dans la zone Enregistrer 
dans : 

• Donnez un nom au fichier (ou document) : la zone Nom du fichier : permet de nommer votre fichier. 
Par défaut, Word y affiche les premiers caractères du texte contenu dans le fichier. Tapez le nom que 
vous désirez dans la zone « Nom du fichier : ». Le type de fichier par défaut est un fichier « word »4, et 
les caractères « .doc » seront automatiquement ajoutés à la fin du nom que vous avez tapé. On parle de 
l’ « extension » affectée au nom de fichier.  

• Validez en cliquant sur le bouton Enregistrer 
• Si l’enregistrement a été correctement effectué, le nom du fichier apparaît dans la barre de titre. 
 

3.2.2 Enregistrement après modification d’un document déjà créé: 
Cliquez sur Enregistrer. Dans ce cas, la boîte de dialogue Enregistrer sous... n’apparaît pas. Vous 
enregistrez ainsi de nouvelles informations dans le fichier précédemment nommé et rangé.  
Vous pouvez également cliquer dans la barre d’outils sur l’icône représentant une disquette.  
Attention : tout enregistrement se conclut par le remplacement intégral de l’ancien contenu d’un fichier par 
le nouveau contenu qui vient d’y être enregistré. 
 

                                                      
4 On peut enregistrer les informations selon un autre format (un autre type). Dans ce cas on choisira le type désiré dans 
la liste accessible en cliquant sur la flèche de la zone Type de fichier : 

Nom du 
fichier 

Type du 
fichier 
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3.2.3 Ouvrir un document déjà existant : 
• Dans le menu Fichier, activez la commande 

Ouvrir… (ou cliquez sur le bouton Ouvrir :  
de la barre d’outils), vous obtenez la boîte de 
dialogue ci-contre: 

• La zone « Rechercher dans : » permet de 
choisir le lecteur et le répertoire de rangement du 
fichier que l’on désire ouvrir. Notez que le système 
laisse paraître dans la liste affichée 
UNIQUEMENT les fichiers qui correspondent au 
type spécifié dans la zone « Type de fichiers : ». 
Par défaut, il s’agit de fichers de type « word », c’est 
à dire terminés par l’extension « .doc ». 
 la boîte de dialogue « Ouvrir…» 

 

3.3 Mise en forme au niveau des caractères 

3.3.1 Affichage des caractères de contrôle  
Les caractères de contrôle sont des caractères normalement invisibles (par ex., le retour à la ligne, l'espace 
tabulation, les espaces...) qui permettent la mise en paragraphe, l'alignement de colonnes, ... Quelque soit 
l'option d'affichage à l’écran (avec ou sans caractères de contrôle), ceux-ci ne sont jamais imprimés.  
Afin de mieux contrôler le travail de mise en forme, affichez les caractères de contrôle en cliquant sur le 
bouton « afficher/masquer » dans la barre d’outils : 
 

 
 

3.3.2 Sélection de texte 
Pour sélectionner : Faire : 
Quelques caractères 
Une suite de caractères ne dépassant pas 
ou peu ce qui est affiché à l’écran 

Cliquer au début du texte à sélectionner, puis faire glisser la souris 
en maintenant le bouton gauche enfoncé, relâcher à la fin du texte. 
Le texte sélectionné apparaît en négatif (ou inverse vidéo) 

Un mot Faire un double-clic sur le mot 
Une ligne Placer le curseur dans la marge gauche du texte (le curseur texte 

se transforme en flèche) et cliquer. 
Un paragraphe Faire un double-clic dans la marge gauche du texte ou un triple-

clic dans le paragraphe 
Un morceau assez long de texte Placer le curseur au début du texte. 

Faire défiler le texte à l’aide du curseur à droite de la fenêtre. 
En maintenant le bouton majuscule × enfoncé, cliquez sur la fin 
du texte. 

Tout le document Menu Edition → Selectionner tout. 
Une ligne de tableau Placer le curseur à gauche de la ligne et, lorsque le curseur à pris 

forme d’une flèche vide Ü, cliquer (attention : le résultat est 
différent lorsque le curseur à pris forme d’un flèche pleine Ò) 
Ou 
Placer le curseur dans la dite colonne, puis cliquer dans le menu 
Tableau sur la commande Sélectionner la Ligne 
Ou 
A l’aide de la souris, cliquer sur la cellule gauche de la ligne à 
sélectionner, puis faire glisser la souris en maintenant le bouton 
gauche enfoncé jusqu’à la droite de la ligne, et relâcher. 

Une colonne de tableau Placer le curseur au dessus de la colonne sur la ligne supérieure 
du tableau (le curseur prend la forme Ð) et cliquer. 
Ou : 
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Placer le curseur dans la dite colonne, puis cliquer dans le menu 
Tableau sur la commande Sélectionner la Colonne 
Ou :  
Placer le curseur dans la dite colonne, puis activer simultanément 
le jeu de touches clavier Ctrl+Alt+L 
Ou 
A l’aide de la souris, cliquer sur la cellule supérieure de la 
colonne à sélectionner, puis faire glisser la souris en maintenant le 
bouton gauche enfoncé jusqu’au bas de la colonne, et relâcher. 

 

3.3.3 Les attributs des caractères (police, taille, style) 
 
 
 
 
 

 
la zone de commande de la fenêtre « Word » avec la localisation des boutons d’attributs de caractères les 

plus courants. 
 
Astuce : Si vous laissez en attente la flèche de votre souris sur une icône de la barre d’outils, vous allez voir 
apparaître une étiquette décrivant la fonction du bouton.  
 
⇒ Pour changer la police des caractères ; sélectionnez du texte, cliquez sur la flèche associée à la zone 
Police , sélectionnez, dans la liste alors déroulée, la police que vous voulez affecter à votre texte. 
⇒ Pour changer la taille des caractères ; sélectionnez du texte, cliquez sur la flèche associée à la zone 
Taille de police, sélectionnez, dans la liste alors déroulée, la taille que vous voulez donner à votre texte. 
⇒ Pour utiliser les options de style : gras, italique, souligné ; sélectionnez du texte, cliquez sur les 

boutons gras , italique  ou souligné . 
 
Attention : Si vous n’avez rien sélectionné, les modifications ne concerneront que le texte que vous taperez 
à l’endroit où se trouve le curseur au moment ou vous spécifiez les choix pour les modifications souhaitées. 
 

3.4 Mise en forme au niveau du paragraphe 
Un paragraphe est une suite de caractères terminée par un retour à la ligne (touche ’Entrée’), qui peut être 
constituée d’un ou de plusieurs mots ou phrases. Il sera utile pour la suite de voir les retours à la ligne dans 
le document afin de reconnaître les limites d’un paragraphe. Cela se fait en cliquant sur le bouton 

‘Afficher/Masquer ¶’ de la barre d’outils :  
 
Les principaux paramètres d’un paragraphe sont : 
• l’alignement, la justification et le centrage 
• le renfoncement (= retraits gauche et droit) 
• l’indentation (= retrait de la première ligne) 
• l’encadrement 
• la couleur de fond 
• l’interlignage 
• les tabulations. 
• Les puces 

Souligné 

Italique

Gras 

Taille de police 

PoliceAfficher/Masquer  

les caractères de contrôle
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Ces paramètres peuvent être appliqués à plusieurs paragraphes simultanément, toujours sur l’intégralité de 
chaque paragraphe. Si vous sélectionnez une fraction de paragraphe seulement, le paramètre sera appliqué à 
l’intégralité du paragraphe sélectionné. Si vous ne sélectionnez rien du tout, le paramètre sera appliqué à 
l’intégralité du paragraphe contenant le curseur. 
 

 
Marges, indentation et renfoncements 

 

3.4.1 L’alignement, la justification et le centrage 
L’alignement, la justification et le centrage du texte se font à l’aide des boutons suivants de la barre d’outils : 

 
Alignement gauche, centrage, alignement droit, justification totale 

 
Lors de la justification totale, les espaces blancs entre les mots sont redimensionnés afin que le texte soit 
aligné à gauche et à droite. Dans ce cas les espaces blancs n’ont alors pas la même taille d’une ligne à 
l’autre. C’est précisément cela qui justifie l’utilisation des indentations et des tabulations pour mettre 
certains paragraphes en retrait plutôt que des séries d’espaces blancs, qui n’auront pas la même dimension 
d’une ligne à l’autre. 
 

3.4.2 Le renfoncement et l’indentation 
Le renfoncement désigne les retraits droit et gauche d’un paragraphe par rapport aux marges du document 
(Figure section 3.4). L’indentation désigne un retrait particulier du côté gauche de la première ligne de 
chaque paragraphe. Ces paramètres sont réglés avec les symboles suivants associés à la règle de la fenêtre : 
 
           Indentation (Retrait de la première ligne) 
 

 
 
  Retrait à gauche       Retrait à droite 
 

Glissières d’indentation et renfoncements sur la règle. 
 
 
Pour appliquer l’un de ces attributs, sélectionnez le ou les paragraphes concernés, puis à l’aide la souris 
faites glisser le symbole associé. 
 
Attention : le symbole Retrait à gauche  est composé de deux parties : 
- Lorsque vous déplacez ce symbole par sa partie basse  vous déplacez dans le même temps de symbole 
d’indentation , 
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- Lorsque vous déplacez ce symbole par sa partie haute  vous ne déplacez que le symbole de retrait à 
gauche. 
 

3.4.3 Encadrement  
Pour un encadrement simple et rapide : sélectionnez le ou 
les paragraphes, et cliquez sur le bouton de la barre 

d’outils :  
Pour un encadrement plus élaboré, utilisez la commande 
Bordure et trames du menu Format. 
Vous voyez apparaître une fenêtre comportant trois parties : 
type, style, aperçu. Dans la partie « aperçu », vous pouvez 
choisir d’enlever ou d’ajouter une bordure de chaque côté 
de votre tableau en cliquant sur les différents boutons.  
Faites vos choix et validez en cliquant sur OK 
 

 

Attention : les encadrements ne donnent de bons résultats que si l’ensemble des paragraphes concernés ont 
les mêmes caractéristiques en ce qui concerne les renfoncements. 
 

3.4.4 Couleur de fond 
Commande Bordure et trames du menu Format. 
L’onglet « Trame de fond » permet de mettre des fonds de 
couleur au texte ou au paragraphe, selon l’option choisie. 
 

3.4.5 Modifier l’interlignage 
Sélectionnez le texte, choisissez dans le menu Format la 
commande Paragraphe : faites votre choix dans la case 
Interligne. Si vous cliquez sur Multiple, spécifiez la valeur 
de l’interligne désirée dans la case De :. 
 

 

3.4.6 Les puces 
Les puces sont des petits symboles (souvent des points noirs) ou des numéros que l’on place en début de 
paragraphe ou de ligne pour mettre en valeurs certains points d’un texte. Par exemple : 

• les rongeurs  
• les coléoptères  
• les arbres  
• les champignons  

Pour appliquer des puces standards : 
Sélectionnez l’ensemble des paragraphes concernés, et cliquez sur le bouton ‘Puce’ de la barre d’outils : 

  ou  
Pour personnaliser les puces et les appliquer : 
Choisissez la commande Format -> Puces et numéros pour sélectionner une forme de puce convenable et 
cliquez sur Ok. Vous pouvez aussi choisir une forme de puce différente en cliquant sur le bouton 
Personnaliser de cette boîte de dialogue.  
 

3.4.7 Les tabulations 
Les tabulations sont des espaces blancs de longueur paramétrable par des taquets que l’on positionne sur la 
règle. Ils permettent par exemple d’aligner des colonnes sans passer par l’outil « tableau ». La démarche à 
suivre pour les utiliser est détaillée dans ce qui suit : 
 
• Sélectionner l’ensemble des paragraphes contenant les éléments à aligner 
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Exemple : 
Jacques Pierre Paul 3.45 
Françoise Catherine Marion 6.50 

 
• Placer sur la règle le ou les taquets de tabulation qui vous seront nécessaires : 
 
Règle vierge : 

 
 
Différents types de taquets sont disponibles dans la boite à taquets à l’extrême gauche de la règle : 

 Taquet d’alignement à gauche, 
 Taquet de centrage, 
 Taquet d’alignement à droite, 
 Taquet d’alignement des chiffres décimaux. 

Ces différents taquets peuvent être sélectionnés en cliquant sur la boîte à taquets jusqu’à faire apparaître le 
symbole désiré. 
Lorsqu’un symbole est sélectionné, le faire glisser à l’aide de la souris sur la règle à l’emplacement désiré. 
 
Exemple de règle avec mise en place de 4 taquets différents : 

 
 
Validez les taquets par insertion d’un espace tabulation devant chaque partie de texte concernée. 
Pour ce faire on vient placer le curseur texte devant chaque partie de texte et on active la touche « Tab » . Si 

l’on est en mode affichage des marques  cela va se traduire par la visualisation à l’écran de symboles 
« flèche » → à chaque emplacement d’un espace tabulation. 
 

 
 
Remarque : ce type d’alignement est également possible à l’intérieur des cellules d’un tableau. Dans ce cas, 
la mise en place d’espaces tabulation à l’intérieur de cellules d’un tableau se fait avec la combinaison de 
touches de clavier « Ctrl » + « Tab ». 
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3.5 Les sections 
 
Une section est un ensemble de plusieurs paragraphes (par exemple un 
chapitre d’un livre). Cet ensemble doit être délimité à son début et sa 
fin par la commande Insertion → Saut... et en cochant ensuite une 
option « Saut de section ». Une telle définition de section permet 
d’appliquer une mise en forme individuelle à un ensemble de 
paragraphes (c’est-à-dire à chaque section).  
Par exemple, on peut mettre une partie seulement d’un document sur 2 
colonnes (sans les sections, le document tout entier est soit à une 
colonne, soit à deux). On peut aussi faire en sorte d’avoir une page 
imprimée en « mode paysage » alors que toutes les autres pages seront 
en « mode portrait ». 
 

texte sur une colonne

texte sur 
2 colonnes

texte sur 
2 colonnes

texte sur une colonne

======= Saut de section (continu) =======

======= Saut de section (continu) =======

 

3.5.1 Pour placer un saut de section : 
Insertion → Saut... et cochez l’option « Saut de section – Continu ». Validez en cliquant sur ’OK’. Si 
l’option 'Afficher/Masquer ¶'  est active, la mention "saut de section (continu)" doit alors apparaître 
encadrée par des doubles traits .  
On choisira l’option « Saut de section – Page suivante » si on désire combiner un saut de section avec un 
saut de page, par exemple pour réaliser des mises en pages différentes pour les pages d’un même document. 

 
 

3.5.2 Mettre une section de texte sur plusieurs colonnes 
 
Placez le curseur à l’intérieur de la section définie 
par 2 sauts de section.  
Maintenant choisissez Format → Colonnes.... 
Dans la boîte de dialogue qui s’ouvre indiquez le 
nombre de colonnes souhaité. Par défaut, les 
colonnes sont séparées par 1,25 cm (‘Espacement = 
1,25 cm’), mais cette valeur est modifiable. Vérifiez 
que « Appliquer : à cette section » est bien affiché 
en bas de la boîte de dialogue. Cliquez sur ‘Ok’. 
 
Pour une mise en colonne rapide et sans options, 
vous pouvez également utiliser le bouton 
« Colonnes » de la barre d’outils. Vous avez 
alors un choix de présenter votre texte sur 1, 2 , 3 ou 
4 colonnes. 

 

 

3.6 Mise en forme au niveau du document 
Les commandes décrites dans cette section s’appliquent en principe à l’ensemble du document. Elles ne 
nécessitent donc pas de sélection préalable. Néanmoins dans certains cas, il est possible d’appliquer la 
commande à une sélection de texte. Nous adressons ici les caractéristiques suivantes : 
 
• les marges 
• l’en-tête et le pied de page 
• la numérotation des pages 
• les notes de bas de page 
• les styles 
• la table des matières 
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3.6.1 Les marges 
La définition des marges est accessible dans la boîte de 
dialogue : Fichier -> Mise en page sous l’onglet 
‘Marges’. Notez que les changements appliqués par 
cette boîte de dialogue peuvent affecter soit le 
document entier, soit le texte qui suit après le curseur, 
soit le texte sélectionné (si on l’a sélectionné 
auparavant). 
Alternativement, les marges droites et gauches peuvent 
être modifiées avec la souris à l’aide de la règle, quand 
vous êtes en mode ‘Aperçu avant impression’, activé 
par la commande Fichier-> Aperçu avant 
impression, ou bien en cliquant sur le bouton:  

 

 

Positionnez la souris entre l’espace blanc et gris à gauche ou à droite de la règle tirez la double-flèche 
apparaissant dans la direction voulue. Fermez ce mode en cliquant sur ‘Fermer’. 
 

3.6.2 En-tête et pied de page, numérotation des pages 
Cette option permet de faire apparaître un texte qui sera automatiquement répété en haut de chaque page (en-
tête) ou en bas de chaque page (pied de page). Par exemple, l’en-tête du présent guide de l’environnement et 
des logiciels est : 
 
UJF Licence Sciences – INF 112 Guide 
 
Pour accéder à cette fonction choisissez : Affichage -> En-tête et pied de page. Vous remarquez que le 
curseur s’est placé en haut de la page du document dans une zone nommée 'En-tête' et délimitée par un 
rectangle qui apparaît en pointillé : 

 
Les dimensions de cette zone sont des attributs de documents (paramètres de mise en page) et peuvent être 
modifiées en activant le bouton 'mise en page' de la barre d'outils flottante qui vient d'apparaître à l'écran (on 
peut jouer sur les marges pour modifier les dimensions de la zone). 

 
Pied de page :  
Pour l’activer cliquez sur le bouton ‘Basculer en-tête/pied-de-page’ de la barre d’outils flottante : 
 
Numérotation des pages dans le pied de page : 
Placez le curseur dans la zone correspondant au bas de page, puis cliquez sur le bouton ‘Insérer le 
numéro de la page’. La numérotation est réalisée automatiquement par l’ordinateur. 

 

 
 



UJF Licence Sciences – INF 112 Guide  

25 

3.6.3 Note de bas de page 
En dépit de son appellation qui ressemble au pied de page, il s’agit de quelque 
chose de bien distinct : une note en bas de page est une annotation qui apparaît une 
seule fois5 dans le document en bas d’une page (ou à la fin du document selon 
l’option choisie) et qui correspond à un numéro inséré dans le texte. La 
numérotation des notes de bas de page est réalisée automatiquement par 
l’ordinateur6. Des exemples sont donnés sur les mots « fois » et « ordinateur » de 
ce paragraphe. 
Pour ajouter une note de bas de page dans votre document : 
Insertion -> Note…Dans la boîte de dialogue qui apparaît, indiquez vos choix. 

Pour supprimer une note, il suffit d’effacer son numéro. 
 

3.6.4 Les styles et la création d’une table de matières 
Un style est un ensemble de plusieurs paramètres de mise en forme, qui, une fois défini, peut être appliqué à 
un texte sélectionné en une seule opération. Vous pouvez ainsi définir un format individuel aux titres, aux 
sous-titres, à l’en-tête et pied de pages, ou à des paragraphes qui ont une fonction commune dans le 
document. De plus, la définition de styles est requise pour la création d’une table des matières automatique 
(voir paragraphe suivant). 
 
1ère étape :Définition du style des titres et sous-titres 
Placez le curseur dans le titre (ou le sous-titre) et choisissez Format → Style. Dans la boîte de dialogue qui 
s’ouvre choisissez ‘Afficher → Tous les styles’. Choisissez le style « Titre1 ». Dans le cadre ’Aperçu’ 
vous voyez les propriétés de ces styles préréglés. Cliquez sur le bouton ‘Modifier’ et ensuite sur Format → 
Police, pour lui attribuer une police et un style personnalisé. Cliquez sur ‘OK’, ‘OK’, ‘Appliquer’. 
Ainsi nous avons défini le style ’Titre1". 
Vérifiez que le menu déroulant ‘Style’ de la barre d’outils (qui se trouve à 
gauche du menu déroulant affichant les polices et qui est représenté ci-
contre), affiche ‘Titre1’ quand vous avez localisé le curseur sur celui-ci : 

2ème étape : Attribution du style ‘Titre1’ à chaque titre (sous-titre) du document 
Pour ce faire, répétez les opérations suivantes pour chaque titre du document:  
• placez le curseur dans le titre d’un chapitre  
• sélectionnez le style approprié dans le menu déroulant des styles.  
 
3.6.5 La Table des matières 
La table des matières reprend automatiquement les titres et sous-titres de tout le document, à condition que 
des styles leur aient été attribués (voir paragraphe précédent) 
 
Placez le curseur à l’endroit voulu pour la table des matières. Choisissez ensuite : Insertion → Table et 
index.... Dans la boîte de dialogue qui s’ouvre sélectionnez l’onglet ‘Table de matières’ et cliquez sur 
‘Options’. Éliminez ou gardez les différents niveaux de titre qui vous intéressent. Validez en cliquant sur le 
bouton ’OK’. Choisissez ensuite un format qui vous convient dans la petite fenêtre à gauche et cliquez sur 
‘Ok’. La table des matières s’insère automatiquement à l’endroit où vous aviez situé le curseur de texte. 
Vous remarquerez, que vous ne pouvez sélectionner cette table qu’en entier (les paragraphes dont elle est 
constituée sont tous solidaires les uns des autres).  
 

                                                      
5 Exemple de note de bas de page. La note numéro 1 se trouve au début de ce document. 
6 Encore un exemple de note de bas de page. Remarquez que chaque note de bas de page, contrairement au 
pied de page, n’apparaît qu’une seule fois dans le document.  
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Remarques :  

☺ Si vous placez la souris sur les numéros de page dans la table, la flèche de celle-ci se transforme en 
main. Cela indique qu’il s’agit d’un lien hypertexte ! Si vous cliquez dessus, vous vous déplacez 
automatiquement au début du chapitre sélectionné. 

☺ Si vous travaillez en modes ‘Affichage → Lecture à l’écran’ ou Affichage → Explorateur de 
documents  la table des matières apparaît dans une deuxième fenêtre à gauche de la fenêtre d’édition du 
texte. Les titres mis en forme à l’aide de styles sont des liens hypertexte, cliquer sur un titre fait apparaître le 
paragraphe correspondant dans la fenêtre d’édition. 

/ Si vous rajoutez encore du texte et déplacez les chapitres sur une autre page que celle indiquée dans la 
table, la table de matières ne sera pas réajustée automatiquement ! Il faut ensuite mettre à jour la Table de 
matières. Pour ce faire, placez-vous dans celle-là et tapez sur la touche de fonction ‘F9’ ! (ou Insertion -> 
Table et index ...) 

/ De nouveaux styles ont été affectés aux paragraphes de la table des matières (style ’TM1’, ‘TM2’…). 
Ces styles peuvent être modifiés par le menu Format → Style... puis ‘Modifier’, Format → Police ...  
Malheureusement, si l’on essaie cette manip, cela bouscule l’alignement de la table des matières. 
 

3.6.6 Index automatique (ou glossaire) 
Créer un index, à la fin d'un document, en deux étapes 
1. Marquer les mots à inclure dans l'index :  
• sélectionner un mot, Insertion/Tables et Index/Index. 
• Choisir entre  Marquer entrée (celui sélectionné seulement)  ou  Marquage auto... (tous les mots 

identiques, sachant toutefois que les majuscules  sont différentes des minuscules). 
• Avec Word 2003:  Insertion/Référence/Tables et index, onglet Index, Marquer entrée, choisir entre 

Marquer ou Marquer tout... 
 
2. Créer l'index : 
• Se placer à la fin du document. Créer un saut de section. 
• Insertion/Tables et Index/Index (avec 2003: Insertion/Référence /Tables et index/Index), choisir un 

Format  de présentation et le nombre de Colonnes. 
• (Si les entrées ne sont pas visibles, au menu Outils/Options/Affichage, ne pas cocher Codes de champ.) 
 

La mise à jour ne se fait pas automatiquement: cliquer dans l'index, appuyer sur F9. 
 
 
Mettez à jour l'index et la table des matières 
L'index et la table des matières ont un point commun : leur contenu n'est pas mis à jour automatiquement. Ils 
deviennent donc caducs quand document évolue car les numéros de pages changent. Pour mettre à jour une 
table ou  un index, faites un clic droit à l'intérieur. Un menu s'affiche : choisissez  Mettre à jour les 
champs.  Si une autre fenêtre s'ouvre, cochez  Mettre à jour toute la table  et validez par  OK.  
 
Construisez un index des mots-clés 
L'index recense la liste des mots-clés utilisés dans le document en indiquant, pour chacun, les pages où il 
apparaît. Un outil, précieux pour le lecteur, que Word vous permet de créer en quelques clics.  
 
Sauvegardez votre document original  
Attention : lorsque vous indexez un document, il est quasiment impossible d'annuler cette opération. Nous 
vous conseillons donc, avant de créer un index, de conserver une copie de votre document sous un autre 
nom, par exemple  Rapport_Sans_Index.  
 
Marquez chaque mot à indexer  
Vous devez d'abord indiquer les mots que vous voulez placer dans l'index. Word va alors accoler à chaque 
occurrence de ces mots un code spécial, normalement invisible et non imprimé. Lors de la création de 
l'index, Word balayera le  document à la recherche de ces codes et en dressera la liste. Dans votre texte, 
sélectionnez le mot que vous voulez placer en index, par exemple  TGV  (le mot apparaissant plusieurs fois, 
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prenez n'importe lequel). Puis déroulez le menu  Insertion, Référence, Tables et index.  Activez l'onglet 
Index.  Dans la fenêtre qui apparaît, cliquez sur  Marquer entrée.  Une nouvelle fenêtre s'ouvre. Votre mot 
s'affiche dans le champ  Entrée.  Cliquez alors sur  Marquer tout,  puis sur  Fermer.  
Procédez de la même manière pour marquer chacun des autres mots à indexer. Hélas, aucun raccourci clavier 
ne permet de simplifier cette succession d'opérations.  
 
Visualisez les codes  
Cette étape est facultative, mais elle vous permet de vérifier les mots que vous avez indexés. Tapez  Ctrl + *  
(la touche  étoile  du pavé numérique). Juste après chaque mot indexé, vous voyez un code entre accolades. 
Ainsi, tous les mots  TGV  sont suivis du code  {"XE "TGV"}. Tapez de nouveau sur  Ctrl + *  pour faire 
disparaître ces codes.  
 
Créez l'index  
Une fois tous les mots indexés, placez le point d'insertion là où vous voulez créer l'index et déroulez le menu  
Insertion, Référence, Tables et index.  Activez l'onglet  Index  et cliquez sur  OK 
 

3.7 Tableaux 

3.7.1 Créer un tableau 
Placez le curseur sur une nouvelle ligne à l’endroit voulu, et choisissez dans le menu Tableau la commande 
Insérer un Tableau. Indiquez le nombre de lignes et de colonnes souhaité dans les zones prévues à cet effet 
et cliquez sur OK. 
 

3.7.2 Modifier la largeur des colonnes :  
Placez le curseur sur la limite verticale de la colonne à modifier. Le curseur prend alors la forme d'un double 
trait vertical accompagné de deux flèches, ce qui permet de faire glisser la limite vers la droite ou la gauche. 
 

3.7.3 Encadrement, trait de séparation  
Sélection  avant encadrement : lors des procédures d’encadrement décrites ci-après le résultat de votre action 
s’appliquera à la sélection que vous avez faite : 
- si vous avez juste placé votre curseur dans une cellule particulière ou si vous avez sélectionné l’ensemble 
du contenu de la cellule, l’action d’encadrement s’adressera à cette cellule particulière, 
- si vous avez sélectionné un ensemble de cellules, l’action d’encadrement s’adressera à cet ensemble de 
cellules sans aucune distinction, 
- si vous n’avez sélectionné qu’une partie du contenu d’une cellule (mot ou paragraphe), l’action 
d’encadrement s’adressera à la sélection (mot ou paragraphe). 
 
Encadrement simple et rapide :  

Après sélection (voir § précédent) cliquez sur le bouton de la barre d’outils :  
 
Choix de barres d’encadrement  : en cliquant sur le petit triangle à droite du bouton, 
on fait apparaître un choix de barres d’encadrement au-dessus, au-dessous, à droite 
ou à gauche de la sélection, ou autour de toutes les cellules. Faites votre choix. 
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Encadrement et traits de séparation plus élaborés :  
Après sélection (voir § précédent) utilisez la 
commande Bordure et trames du menu Format. 
Vous voyez apparaître une fenêtre comportant trois 
parties : type, style, aperçu. Dans la partie « aperçu », 
vous pouvez choisir d’enlever ou d’ajouter une 
bordure de chaque côté de votre tableau en cliquant 
sur les différents boutons ou directement sur 
l’aperçu. 
Faites vos choix et validez en cliquant sur OK 

 

3.8 Correcteur orthographique 
Pour activer le correcteur orthographique il faut procéder en deux étapes : 

(1) faire le choix de la langue de travail en activant : menu Outils → Langue. Dans la boîte de dialogue 
« Langue », sélectionnez la langue de votre choix (ici : Français (standard)) puis cliquez sur le 
bouton « Par défaut… », validez par le bouton OK, 

(2)  activez ensuite le correcteur orthographique : menu Outils → Grammaire et orthographe 
 
Choix de la langue : Outils →  Langue 

 

Outils →  grammaire et orthographe 

 

3.9 Insertion d’images dans un document 

3.9.1 Image dans un fichier au format image (insertion directe) 
Cette méthode fonctionne uniquement avec des fichiers images déjà enregistrés quelque part dans votre 
espace disque : par exemple, une image que vous avez récupérée sur le Web, ou bien une image prise avec 
un appareil photo numérique. Les formats d’image les plus courants sont jpg, png, gif, l’extension du nom 
du fichier nous renseigne sur le type de format. 
Pour la technique de récupération d’image du Web, voir la section 6.4 de ce guide : « Enregistrer une image 
du Web sur votre espace disque ». 
Pour insérer une image dans votre document, placez le curseur à l’endroit voulu, puis activez la commande 
Insérez →  Image à partir du fichier. Une boîte de dialogue permettant de parcourir l’espace disque et de 
sélectionner un fichier apparaît alors. Cette boîte de dialogue est analogue dans son fonctionnement à celle 
qui permet d’ouvrir un fichier, mais attention : elle vous présentera UNIQUEMENT les fichiers de type 
« image ». Tous les autres (documents word, excel, …) seront ignorés.  
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3.9.2 Image intégrée dans un autre document (Copier-coller)  
• Ouvrez le fichier contenant l’image et celui de 

destination.  
Pour naviguer facilement entre 2 fichiers ouverts 
avec le même logiciel (seul l’un des 2 est visible) 
utilisez le menu « Fenêtre » qui vous donne la liste 
de tous les fichiers ouverts. Si les fichiers sont 
ouverts avec 2 logiciels différents, utilisez la barre 
des tâches pour passer de l’un à l’autre. 
• Dans le fichier contenant l’image, sélectionnez 

l’image en cliquant dessus avec le bouton droit 
de la souris. Dans le menu flottant contextuel qui 
apparaît choisissez « copier ». 

• Dans le fichier destination, placez le curseur à l’endroit voulu pour l’insertion de l’image. 
• Utilisez la commande Edition → Collage spécial. Dans la boîte de dialogue qui apparaît, choisir le 

format « image » dans la liste proposée, et décochez l’item «  dissocier du texte ». 
L’image est ainsi insérée dans votre texte de la même manière qu’un caractère alphanumérique quelconque. 
Elle peut être alignée dans le texte à l’aide des boutons d’alignement de la barre d’outils (voir paragraphe 
3.4.1 de ce document). 
 
Un copier-coller simple est possible, mais cette méthode est fortement déconseillée : l’image est alors 
dissociée du texte et peut être déplacée à la souris, c’est ce que l’on appelle une image « ancrée7 ». 
Malheureusement, lorsque l’on retravaille un document contenant une image ancrée (par exemple pour 
rajouter du texte), l’image a une fâcheuse tendance à se promener toute seule dans le texte, ce qui donne un 
résultat désastreux. 
 

3.9.3 Pour modifier le format de l’image : 
Cliquez sur l’image avec le bouton gauche de la souris pour la sélectionner. Un cadre noir avec des poignées 
(petits carrés noirs) autour de l’image apparaît, ainsi que la barre d’outils flottante8 reproduite ci-dessous : 

 
En laissant la souris quelques secondes immobile sur un bouton, vous verrez apparaître une étiquette vous 
renseignant sur leurs fonctions. En cliquant sur chacun des boutons vous pourrez en découvrir davantage. 

Le 3ème bouton en partant de la gauche  est le format de l’image, c’est celui qui permet de modifier les 
paramètres de format de l’image par l’intermédiaire de la boîte de dialogue ci-dessous :  
Ses fonctionnalités sont classées 
dans les différents onglets :  
Couleurs et traits,  
Taille,  
Position,  
Habillage,  
Image,  
Zone texte. 
Faites vos choix et cliquez sur OK 

 

                                                      
7 Une petite ancre apparaît dans la marge gauche à proximité de l’endroit où était placé le curseur lors de 
l’insertion de l’image. 
8 Si la barre d’outils flottante n’apparaît pas spontanément à l’écran, activez la par : menu Affichage → 
Barres d’outils → Image. 
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4 Logiciel de dessin : PowerPoint 
 
PowerPoint est un logiciel de dessin permettant de faire des présentations (sur transparents ou animées). 
  
Une présentation constitue donc le document de base de Powerpoint, tout comme un document est la base de 
Microsoft Word et un classeur la base de Microsoft Excel. De même, tout comme un document est formé de 
plusieurs pages et un classeur de plusieurs feuilles, une présentation est constituée de plusieurs diapositives 
(ou transparents). Il existe différentes sortes de présentations et de diapositives pré-définies en PowerPoint.  
 
Version utilisée au DLST : Microsoft PowerPoint 97 
 

4.1 Démarrage, interface, opérations sur les fichiers 

4.1.1 Lancer Power Point 
Pour lancer Microsoft Power Point : Démarrer → Programmes → Microsoft PowerPoint 
Ou bien cliquez sur l’icône du bureau (si elle est présente) : 
  

4.1.2 Créer un nouveau fichier 
A la suite du lancement de Power Point, la boîte de dialogue « Power Point » apparaît avec 3 options : les 2 
premières proposent des jeux de présentations avec plans standards et mises en forme, la troisième option 
(Nouvelle présentation) propose une présentation vierge. C’est celle qui nous intéressera. 
 

 
 

 
Après validation de notre 1er choix, un nouveau diaporama est créé, mais ne comporte aucune diapo. Celles-
ci devront être créées successivement. Une deuxième boîte de dialogue « Nouvelle diapositive » apparaît 
alors aussitôt après, proposant un première diapo selon diverses mises en pages : diapositive de titre, liste à 
puces, texte sur 2 colonnes, etc …  
Pour faire un diaporama dans lequel les titres des diapos apparaissent sur les outils de navigation, il est 
important de choisir des types possédant un titre de diapo (schématisé ici par une bande grise en haut ou au 
milieu de la diapo). 
Faites votre choix et cliquez sur OK. 
 

4.1.3 Créer une nouvelle diapositive 
Les diapos suivantes pourront être générées par la commande « Insertion -> Nouvelle diapositive » qui 
reproposera cette dernière fenêtre. 
La commande « Insertion -> Dupliquer la diapositive » permet de faire une copie à la suite de la diapositive 
affichée. 
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4.1.4 Interface 
Vous vous apercevrez que les barres qui apparaissent lors de l’ouverture de la fenêtre par défaut sont 
identiques aux barres de Word et d’Excel (barre de menu, barre d’outils, barre d’état, barre de dessin). En 
effet, on retrouve les mêmes fonctionnalités dans les trois logiciels (Word, Excel et PowerPoint), ce qui 
d’ailleurs nous permet d’importer ou d’exporter des objets et des macros-commandes d’un logiciel à l’autre.  
 
Barre de titre     
 
Barre de menus 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Mode diapositive 
(pour l’édition) 
 
  

 
 
 
Barres 
d’outils 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Barre 
d’outils de 
dessin 
 

 Mode plan 
  

Mode trieuse 
de diapositives 

  Mode diaporama 
  (Défilement des diapositives plein écran) 
 

 

 

 
Powerpoint offre plusieurs modes de d’affichage des diapositives (voir ci-dessous).  
• Le mode diapositive permet l’affichage pleine page d’une diapositive. Ce mode est souvent utilisé pour 

l’édition du contenu de la diapositive (voir ci-dessus). 
• Le mode diaporama permet le Défilement des diapositives plein écran. Ce mode est utilisé lors d’une 

présentation ou d’un exposé. Pour faire défiler les diapos, 
• Appuyez sur la barre d’espace ou cliquez avec la souris.  
• Les curseurs haut et bas permettent d’avancer ou de reculer.  
• Pour aller à une diapo précise, ou mettre fin au diaporama, déplacez la souris vers le coin inférieur 

gauche de l’écran jusqu’à voir apparaître un petit triangle noir pointant vers le haut. Celui-ci donne 
accès à un menu de navigation. On y accède également par un clic droit de la souris. 

• Si les titres ont été indiqués dans chaque diapo, ils vont apparaître dans ce menu, ce qui est très utile 
pour se repérer dans le diaporama. 

• Le mode plan permet d’afficher le texte contenu dans les diapositives de façon synthétique. 
• Le mode trieuse permet de modifier l’ordre de diapositives dans le fichier. Il permet aussi de copier-

coller des diapositives (dans un même fichier ou d’un fichier à l’autre).  
• Le mode commentaire permet d’associer des commentaires à chaque diapositives. Ces commentaires ne 

s’affiche pas lors du diaporama, mais peuvent être imprimés.  
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Mode plan Mode trieuse Mode commentaires 
 

4.1.5 Ouvrir, enregistrer 
Les opérations sur les fichiers (ouvrir, enregistrer) sont identiques à celles de Word (cf § 3.2.). 
 

4.2 Outils de dessin 
Nous allons nous concentrer sur la barre d’outils Dessin, en bas de la fenêtre (si elle n’apparaît pas 
directement à l’écran, utilisez la commande Affichage → Barres d’outils → Dessin).  
 
    Trait Rectangle Couleur de remplissage  Epaisseur de trait 
 
 

 
 
 
                 Flèche Ellipse   Couleur des contours 
 
La barre d’outils Dessin (en bas de la fenêtre) permet de dessiner des formes pré-définies ou des formes 
libres, d’ajouter du texte aux dessins, d’insérer des objets (images, tableaux , …), de modifier les attributs 
des objets.  
 
Le principe de création d’un objet graphique est le même pour toutes les applications : dans la barre d’outils 
Dessin, il faut activer l’outil correspondant à l’objet que l’on veut dessiner, puis, sur la diapositive sur 
laquelle on travaille, le tirer à l’aide de la souris. On distingue notamment quatre formes de base : 
 

-   (Trait) : utilisé pour tracer un segment. Pour obtenir un segment parfaitement horizontal (ou 
vertical), il faut maintenir la touche MAJ enfoncée pendant que l’on dessine le segment en faisant glisser 
le curseur à 15° près.  

-  (Flèche) : permet de dessiner un trait fléché, parfaitement horizontal (ou vertical) si l’on maintient 
la touche MAJ enfoncée pendant l’opération. 

-  (Rectangle) : dessine un rectangle là où on clique et on fait glisser le curseur. Pour obtenir un carré, 
il faut maintenir la touche MAJ × enfoncée pendant l’opération. Si l’on veut tracer l’objet depuis son 
centre plutôt que depuis son périmètre, il faut maintenir la touche CTRL enfoncée. En maintenant 
simultanément enfoncées les touches MAJ × et CTDL on peut tracer un carré depuis son centre.. 

-  (Ellipse) : dessine une ellipse. Pour obtenir un cercle, maintenir la touche MAJ enfoncée ; le 
maintient de la touche CTRL enfoncée permet de tracer l’objet depuis son centre. 

 
Les outils Couleur de remplissage, Couleur des contours, Style de trait et Style de flèche permettent de 
choisir les attributs par défaut des objets dessinés.  
 
Si on veut changer ces attributs une fois qu’un objet a été dessiné, il faut le sélectionner et double cliquer 
avec la souris : la fenêtre Options de formes apparaît alors, vous permettant de modifier la couleur de 
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remplissage et les traits de la forme sélectionnée, sa position (coordonnées X et Y sur la diapositive) et sa 
taille (dimensionnement et rotation par rapport à la forme dessinée). 
 

 
 

4.3 Numéroter les diapos 
Insérer -> En-tête et pied de page 
Cochez « numéro de diapositives » puis cliquez sur « appliquer partout ». 

4.4 Arrière-plan des diapos 

4.4.1 Couleur de fond : 
Dans le menu, Format -> Arrière-plan, la flèche donne accès à un menu (ci-dessous) qui permet de choisir 
parmi des couleurs, des motifs, des textures, des dégradés … Choisir une couleur dans la palette des couleurs 
récentes, ou aller dans « Couleurs supplémentaires » qui offre un choix plus large. 
 
 « Appliquer partout » fait porter la modif sur l’ensemble des diapos 
« Appliquer » seulement sur la diapositive visible. 

4.4.2 Dégradés, motifs, textures, et images d’arrière plan 
Même démarche que précédemment, puis dans la palette de couleurs choisir « Motif et textures », ce qui 
donne la boîte de dialogue ci-contre : 
 
L’onglet « Texture » donne accès à une palette de texture de fond prédéfinies (en fait, des images à pavage 
répétitif). On peut aussi fabriquer la sienne à partir d’une image externe. 
L’onglet « Image » permet de mettre une image de son choix (photo, …) en arrière-plan. 

4.5 Masque des diapos 
Les masques des diapositives permettent de fixer des styles particuliers pour les textes standards (titre, zone 
de texte, pied de page, zone de numéro de page, …) de l’ensemble des diapos : on peut ainsi modifier la 
taille de police, la couleur des caractères, la couleur de fond, la dimension et la position du de la zone de 
texte, etc … pour toutes les diapos à la fois. Les paramètres choisis s’appliqueront également aux diapos 
nouvellement créées. 
 
Affichage -> Masque -> Masque des diapositives 
 
Par exemple : 
• Pour mettre tous les titres de diapos en rouge : cliquer dans la zone de titre (mode édition de texte), puis 
Format -> Police. Dans la boîte de dialogue, sélectionnez le style, la police, et la couleur rouge. 
• Pour mettre sur fond bleu : cliquer sur le bord de la zone de texte (mode édition de forme), puis 
sélectionner le fond bleu dans la barre d’outils dessin en bas de la fenêtre. 
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• Pour modifier la taille de la zone du titre : cliquer dans ou sur la zone de titre. Des « poignées », c’est à 
dire des petits carrés blancs apparaissent, qui permettent de redimensionner la zone de texte du titre à la 
souris.  
• Pour modifier la position de la zone du titre : maintenir cliqué le bord de la zone de texte en dehors des 
poignées (une croix apparaît), et tirer. 
 
Les autres zones de texte se travaillent de la même façon. 
Pour revenir à l’édition des diapos, cliquez sur le mot « Fermer » de la mini-fenêtre « Masque, fermer » (Ne 
pas cliquer sur le bouton de fermeture X de cette mini-fenêtre, car cela ferme la mini-fenêtre sans fermer le 
masque). 

4.6 Animations 
La commande :Diaporama -> Prédéfinir l’animation -> … donne accès à un menu proposant une liste 
d’ « apparitions » prédéfinies, telles que : damiers aléatoires, apparaître, ouverture verticale, balayage, etc. 
Pour l’utiliser, sélectionner un élément à faire apparaître, puis appliquer la commande souhaitée.  
S’il y a plusieurs éléments à faire apparaître à la suite, répéter l’opération en prenant les éléments dans 
l’ordre d’apparition souhaité. 
 
Par défaut, les éléments apparaîtront dans leur ordre de mise en place. Pour modifier l’ordre, la durée 
d’apparition : Diaporama -> Personnaliser l’animation . Cette même boîte de dialogue permet également 
de modifier l’ordre d’apparition des différents éléments. 
 
On peut tester l’animation dans une petite fenêtre : Diaporama -> Aperçu de l’animation ou en passant en 
mode diaporama 

4.7 Macros 

4.7.1 Enregistrement d’une macro  
Avant de commencer l’enregistrement, PowerPoint doit 
être ouvert sur une diapositive, de préférence vide. 
Pour démarrer l’enregistrement d’une macro : menu 
Outils → Macro → Nouvelle macro. La boîte ci-
contre apparaît. Par défaut, la macro s’appelle 
‘Macro1’, renommez-la d’un nom plus explicite et 
cliquez sur OK. 

 
A partir de maintenant, vous êtes en mode d’enregistrement de la macro  
Tracez les figures ou éléments souhaités, sans vous tromper : toutes les opérations que vous faites sont 
enregistrées. 
 
Pour arrêter l’enregistrement d’une macro, il vous suffit de retourner dans le menu Outils → Macro. Le 
menu affiché s’est modifié et vous propose maintenant d’arrêter l’enregistrement. 
Une autre méthode plus rapide est possible. Lorsque vous avez commencé l’enregistrement de la 
macro, une icône « arrêt de l’enregistrement » est apparue (il se peut qu’elle n’apparaisse pas, 
cela dépend de la configuration du logiciel, dans ce cas utilisez la méthode précédente). Un 
simple clic sur le carré bleu permet de suspendre l’enregistrement. 
Attention : si vous cliquez sur la case de fermeture dotée d’une croix, vous allez fermer cette mini-fenêtre, 
mais vous n’arrêterez pas l’enregistrement de la macro. 
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4.7.2 Exécution d'une macro  
Avant de commencer l’exécution de macros 
précédemment enregistrées, PowerPoint doit être 
ouvert sur une diapositive, de préférence vide. Il faut 
au minimum que le dessin de la macro à exécuter ne 
soit pas déjà présent sur la diapositive, sinon on ne 
verra pas le résultat de la macro ! 
Pour exécuter une macro : 
Sauvegardez, 
Menu Outils → Macro → Macros … ou ALT F8 
Dans la boîte de dialogue qui apparaît (reproduite ci-
contre) sélectionner la macro à exécuter (s’il n’y a 
qu’une macro, la sélection est automatique), puis 
cliquez sur le bouton « Exécuter »  
Vous allez voir les diverses actions de la macro se 
dérouler sur votre écran dans l’ordre exact où elles ont 
été enregistrées. 
 

 

4.7.3 Observation et édition du code d’une macro  
Pour observer ou éditer le code d’une macro procédez tout d’abord comme pour l’exécution : 
Menu Outils → Macro → Macros … ou ALT F8 et sélectionnez la macro à éditer. 
Cliquez sur le bouton « Modifier ». Une nouvelle fenêtre s’ouvre alors, c’est l’éditeur de Visual Basic 
Applications (VBA). 
La compréhension du langage de Visual Basic permet, entre autres, de corriger d’éventuelles erreurs dans 
votre macro et d’automatiser simplement certaines tâches. 
L’éditeur se manipule comme un document Word, nous avons ajouté les spécificités principales sur le schéma 
présenté ci-après.  
Une fois vos modifications effectuées, sauvegardez, et revenez dans l’environnement diapositive en cliquant 
sur le bouton à l’extrémité gauche de la barre d’outils.  

 
 
 

Lance l’exécution 
d’une macro 

Permet de passer d’une 
macro à l’autre Permet de retourner 

en mode diapositive et 
de voir le résultat de 
la macro 
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4.7.4 Comment utiliser une touche clavier comme raccourci pour l’exécution 
d’une macro ? 

On peut choisir de définir l’utilisation d’une touche de clavier pour rendre l’exécution d’une macro automatique ; 
suivre alors le protocole suivant : 
 
Options de barre d’outils (flèche vers le bas à droite du point d’interrogation) 
→ Ajouter/Supprimer des boutons 
→ Personnaliser … 
 → onglet « Commandes » 
 Catégories: Macros ; 
 Enregistrer dans : Sequence.doc 
 Commandes : « RemplacerBlancParTabulation » ; 
 bouton clavier → Catégories : Macros ; 
  Enregistrer dans : Sequence.doc 
 Commandes : « RemplacerBlancParTabulation »  
 Nouvelle touche de raccourci : 
 fixer votre jeu de touches clavier par exemple : Alt+T 
 valider par Attribuer 
 fermer 
→ fermer 
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5 Excel 
 
Le tableur-grapheur Excel est un outil de calcul et de simulation permettant de visualiser les 
données sous forme graphique. 
 
Version utilisée au DLST : Microsoft Excel 97 

5.1 Démarrage et interface 

5.1.1 Lancer Excel 
Pour lancer Microsoft Excel: Démarrer → Tous les programmes → Microsoft 
Excel 
Ou bien cliquez sur l’icône du bureau (si elle est présente) :  

5.1.2 La fenêtre Excel 
La fenêtre du tableur Excel possède la même apparence que celle du traitement de texte Word : barre de 
menu, barre d'outils, barre d'état... Pour avoir des explications sur une icône de la barre d’outils Excel, il 
suffit de pointer l’icône avec la souris et une info-bulle apparaît. 
La fenêtre d’un document tableur est composée d'un quadrillage appelé feuille de calcul. Une case de ce 
quadrillage est dénommée cellule. Les cellules sont repérées à l'aide des indicateurs de lignes et de colonnes 
à la manière d'un jeu de bataille navale. 
 

Nom du document   Barre d’édition    Indicateurs de colonne Barres de défilement 

Barre de titre 
Barre de menus 
 
Barres d’outils 
Zone “Nom” 
 
 
 
 
Cellule active 
 
 
Plage de cellules 
 
 
 
Indicateurs de ligne 
 
 
 
Onglet de feuille 
Barre d’état 

 
la fenêtre Excel 

 
Les colonnes vont de A à Z, puis de AA à AZ et ainsi de suite jusqu’à IV. Les lignes vont de 1 à 65536. 
C’est le style de références par défaut, nommé A1. Un autre style de références existe, il sera abordé avec les 
macros. 
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5.1.3 La barre de menus 
Dans les menus, vous verrez que certaines commandes sont accompagnées d’une séquence de touches qui 
constitue un raccourci. Taper cette séquence de touches équivaut à appeler la commande depuis le menu. Ces 
raccourcis peuvent être bien utiles pour les commandes fréquentes (par exemple Copier, Coller, etc). 
 
Certaines commandes sont également accessibles en utilisant le bouton droit de la souris… Essayez ! 
 
Fichier Edition Affichage Insertion 
Nouveau... 
Ouvrir... 
Fermer… 
Enregistrer 
Enregistrer sous… 
Enregistrer un environnement… 
Mise en page… 
Zone d’impression   -> 
Aperçu avant impression 
Imprimer… 
Envoyer vers  -> 
Propriétés 
1 Z:\toto\…\Classeur4.xls 
2 Z:\toto\…\Classeur3.xls 
3 Z:\toto\…\Classeur2.xls 
4 Z:\toto\…\Classeur1.xls 
Quitter 
 
 

Annuler la commande 
Répéter la commande 
Couper 
Copier 
Coller 
Collage spécial… 
Coller comme lien hypertexte 
Recopier   -> 
Effacer   -> 
Supprimer… 
Supprimer une feuille 
Déplacer ou copier une feuille… 
Rechercher… 
Rehercher… 
Remplacer… 
Atteindre… 
Liaisons… 
Objet 
 

Normal 
Aperçu des sauts de page 
Barres d'outils -> 
Barre de formule 
Barre d’état 
En-tête et pied de page… 
Commentaires 
Affichages personnalisés… 
Plein écran 
Zoom 
 

Cellules… 
Lignes 
Colonnes 
Feuille 
Graphique… 
Saut de page 
Fonction… 
Nom  -> 
Commentaire 
Image  -> 
Carte… 
Objet… 
Lien hypertexte… 
 
 
      

 
 
Format Outils Données Fenêtre 
Cellule… 
Ligne   -> 
Colonne   -> 
Feuille   -> 
Mise en forme automatique… 
Mise en forme conditionnelle… 
Style… 
 

Orthographe… 
Correction automatique… 
Rechercher une référence… 
Partage du classeur Excel… 
Suivi des modifications -> 
Fusionner les classeurs… 
Protection  -> 
Valeur cible… 
Gestionnaire de scénarios… 
Audit   -> 
Macro   -> 
Macros complémentaires… 
Personnaliser… 
Options… 
Assistant  -> 

Trier… 
Filtre   -> 
Grille… 
Sous-totaux… 
Validation… 
Table… 
Convertir… 
Consolider… 
Grouper et créer un plan -> 
Rapport de tableau croisé… 
Données externes 
 -> 
Actualiser les données 

Nouvelle fenêtre 
Réorganiser… 
Masquer 
Afficher… 
Fractionner 
Figer les volets 
1 Classeur1 
 
 

 
les menus déroulants d'Excel 

 

5.2 Manipulation et contenu des cellules 

5.2.1 Sélectionner 
Un curseur de cellule est une boîte rectangulaire qui désigne la cellule active, c'est-à-dire la cellule qui peut 
être éditée : 
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Une plage de cellules est définie comme un bloc de cellules adjacentes. 
Par exemple : les cellules à l'intersection des colonnes B, C, D et des lignes 5 à 11 de la figure section 5.1.2. 
 
Pour déplacer le curseur de cellule, plusieurs possibilités existent : 
 � utiliser les flèches du clavier (haut, bas, gauche, droite) ; 
 � cliquer avec le bouton gauche de la souris sur la cellule désirée ; 
 � utiliser la commande Edition → Atteindre… et entrer la référence (les coordonnées) de la cellule 
désirée. 
 
Pour sélectionner un groupe de cellules (plage de cellules), c'est à dire les marquer en vidéo inverse afin de 
désigner les cellules concernées par une commande (attention : la cellule située sous le curseur cellule au 
moment du début de la sélection est incluse dans la plage bien qu'elle apparaisse en blanc lors de la 
sélection) : 
 � cliquer sur une cellule située dans un des coins de la zone rectangulaire à sélectionner et faire 
glisser le pointeur jusqu'à la cellule située dans le coin opposé ; par ex : B5 à D11. 
 � pour modifier l’étendue de la sélection, appuyer sur la touche majuscule MAJ × et la garder 
enfoncée pendant que l'on clique sur une nouvelle cellule ; 
 � pour faire des sélections multiples, c'est à dire des sélections/désélections de cellules individuelles 
ou de champs de cellules qui ne sont pas adjacents, cliquer sur ces cellules conjointement à l'appui de la 
touche CTRL ; 
 � pour sélectionner une ligne ou une colonne entière, cliquer sur les indicateurs de colonne ou de 
ligne lorsque le curseur de souris devient ou . 
 

5.2.2 Saisir et éditer des données 
Pour saisir des données dans une cellule vide, rendre cette cellule active et commencer à taper. Le texte, la 
valeur ou la formule tapés apparaît dans la barre d’édition, et s'affiche également dans la cellule 
correspondante. La saisie peut être confirmée en activant la touche Entrée (la saisie est alors validée dans la 
cellule sélectionnée) ou annulée en activant la touche Echappement (en haut à gauche du clavier « Echap »). 
On peut également utiliser les boutons correspondants sur la barre d’édition: 
 
   Annuler Confirmer  Point d’insertion 
 

 
 
Pour modifier les données de la cellule active, plusieurs méthodes sont possibles : 
 � cliquer sur un caractère dans la d’édition. Un curseur (clignotant) d’édition apparaît, vous pouvez 
alors modifier la ligne à l'aide du clavier et de la souris, 
 � commencer à taper, les nouveaux caractères remplaceront les données existantes. 
 

5.2.3 Saisie de Nombres, Formules et Libellés 
Un nombre peut être un nombre entier, un nombre en virgule flottante (ex : 1,2e-3) ou une date (ex : 
01/10/92) ou autres : plusieurs catégories existent, voir la commande : menu Format → Cellule → 
Nombre. 
Une formule doit être saisie en commençant par le caractère = . 
Un libellé, ou texte, doit commencer par un caractère non numérique. Si le libellé à faire apparaître débute 
par un caractère de début de nombre ou de formule, le faire précéder par une apostrophe. 
 

5.2.4 Copie et déplacement de cellules 
Démarche à suivre : 
 - Sélectionner la (ou les) cellule(s) à copier 
 - menu Edition → Copier 
 - Sélectionner la cellule en haut à gauche de la zone de destination dans laquelle on veut placer la copie 
 - menu Edition → Coller 
Le déplacement du contenu de cellules se fait de manière identique avec la commande « Couper ». 
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Les modalités d’utilisation générales (non spécifiques à Excel) du Copier-coller sont détaillées dans le § 
1.5.5 de ce guide. 
 

5.2.5 Syntaxe des Formules dans le style de référence A1 
Une formule commence par le caractère =  et comporte des constantes, des opérateurs, des fonctions ou des 
références à des cellules. 
Exemples valides : =B4+5  
      =SOMME(B4:C9) 
Exemple incorrect :  B4+5 (Cela sera pris comme du texte, et apparaîtra tel quel dans la cellule) 
Attention à ne pas taper d'espace blanc avant le caractère =, le contenu de la cellule sera alors considéré par 
l'ordinateur comme du texte. 
 
 1. Référence à une cellule 
 
Une formule apparaissant dans une cellule peut faire référence à la valeur d’une autre cellule. Par exemple, 
si la cellule A2 contient la formule =A1+3, cette formule fait référence à la valeur de la cellule A1. Ainsi, 
quelle que soit la valeur contenue dans la cellule A1 (par exemple 67,8), la cellule A2 vaudra cette valeur 
plus trois (ici 70,8). Une formule peut faire référence à une cellule de manière relative ou absolue ou mixte. 
 
� Référence relative : dans la formule, les coordonnées d'une cellule-cible sont données relativement à la 
cellule où apparaît la formule. Pour entrer une référence relative dans une formule, tapez simplement 
l'adresse de la cellule-cible, comme dans l’exemple précédent =A1+3. En fait, la formule contenue dans la  
cellule A2 fait référence à la valeur de la cellule située au-dessus d’elle (A1). Si on copie/colle la cellule A2 
vers la cellule B5, le contenu de celle-ci (B5) deviendra =B4+3. 
 
� Référence absolue : dans une formule, les coordonnées d’une cellule-cible sont données indépendamment 
de la cellule où apparaît cette formule. Pour entrer une référence absolue dans une formule, faites précéder 
les indicateurs de ligne et de colonne du symbole dollar, par exemple =$A$1+3. Cette formule fait référence 
à la valeur de la cellule de la colonne A et de la ligne 1 (A1), quelle que soit la cellule où apparaît cette 
formule. Dans ce cas, si on copie/colle la cellule A2 contenant cette formule vers la cellule B5, le contenu de 
celle-ci (B5) restera =$A$1+3. On choisira une référence absolue en particulier lorsqu'on utilise une 
constante dans une feuille de calcul. 
 
� Référence mixte : combinaison de références absolues et relatives, par exemple =$A1+3 (référence 
absolue pour la colonne, référence relative pour la ligne). Un copier/coller de cette formule de A2 vers B5 
transformera la formule en =$A4+3. 
 
 2. Référence à une plage de cellules 
 
Une plage de cellules est une zone rectangulaire de cellules référée par les cellules en haut à gauche et en bas 
à droite de la plage séparées par deux points, par exemple B5:D11 (exemple sélectionné dans la figure de la 
section 5.1.2). 
 
 3. Copie de formules 
 
Lorsque l'on recopie (avec Copier/Coller) une formule d'une cellule dans une ou plusieurs autres, les 
références à des cellules sont réactualisées ou non en fonction de leur nature. Les indicateurs précédés du 
symbole dollar sont conservés tandis que les autres s’adaptent à la nouvelle cellule. 
 
Exemples : 
Si vous copiez =20+B4 de B1 dans G2, la formule devient =20+G5. (référence relative) 
Si vous copiez =20+$B$4 de B1 dans G2, la formule reste =20+$B$4. (référence absolue) 
Si vous copiez =20+B$4 de B1 dans G2, la formule devient =20+G$4. (référence mixte) 
 
 4. Déplacement de formules 
 
Lorsque l'on déplace (avec Couper/Coller) une formule d'une cellule à une autre, les références que la 
formule contient ne sont pas réactualisées. 
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Exemples : 
Si vous copiez =20+B4 de B1 dans G2, la formule reste =20+B4. 
Si vous copiez =20+$B$4 de B1 dans G2, la formule reste =20+$B$4. 
Si vous copiez =20+B$4 de B1 dans G2, la formule reste =20+B$4. 
 
 5. Opérateurs arithmétiques, de comparaison, et fonctions logiques 
 
Op. arithmétiques  Op. de comparaison  Fonctions logiques 
Addition  +   Egal  =   Condition  SI(  ;  ;  ) 
Soustraction  -   Strictement supérieur  >   Et logique   ET(   ;   )  
Multiplication  *   Strictement inférieur  <   Ou logique OU(   ;   ) 
Division  /   Supérieur ou égal  >=   Négation logique NON( )  
  Inférieur ou égal  <=    
  Différent  <>    

 
 6. Fonctions intégrées 
Une vaste bibliothèque de fonctions intégrées est disponible, nous n'en utiliserons qu'un petit sous-ensemble. 
Le tableau ci-dessous donne la plupart de celles dont nous nous servirons. 
 
Fonction Syntaxe Signification 
SI SI (Condition; Action Vrai; Action Faux) Condition 
SOMME SOMME (C3:C14) Somme 
ET ET(B8=0; A2<A3) Et logique 
OU OU(B1<>0; A1=1) Ou logique 
NON NON(B6=0) Non logique 
INDEX INDEX(plage de cellules; ligne; colonne) Adressage de cellule 
MOD MOD(D6;F4)    

D6 et F4 contiennent des valeurs numériques 
entières 

Reste de la division entière  
(modulo) 
D6 (nombre) et F4 (dénominateur) 

ENT ENT(F3)   F3 contient une valeur numérique d’un 
type quelconque (réel, entier, …) 

Partie entière d'un nombre 

PUISSANCE PUISSANCE(B2; 2) Elévation à la puissance (Contenu 
de B2 puissance 2) 

PI PI( ) 
Parenthèses vides obligatoires 

Valeur (approchée) de π 

ALEA ALEA( ) 
Parenthèses vides obligatoires 

Valeur aléatoire  
entre 0 (inclus) et 1 (exclu) 

FREQUENCE Fonction matricielle renvoyant un tableau de 
nombres.  

Distribution des effectifs 

 
Pour avoir un aperçu de l’ensemble des fonctions intégrées 
disponibles, choisissez :  
menu Insertion → Fonction... 
 
La boîte de dialogue ci-contre apparaît : 

- choisir la catégorie de fonction, 
- se déplacer dans la liste des fonctions disponibles. 

 
 
 

la boîte de dialogue « Coller une fonction »  

 
7. Exemples de formules 
Exemples valides :  
 =SI(M8>=10;"Reçu";"Collé") 
 =SI( ET(A2="vendredi";B2=13) ;"jour de chance"; "jour normal") 
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 =SI(E15<0;"negatif";SI(E15=0;"nul";"positif")) 
 =SI( OU(J3<5;J3>10) ;J3+1; C2+D5) 
 
Exemples incorrects :  

=SI( J3<5 OU J3>10 ;J3+1; C2+D5)  La syntaxe du « OU » est incorrecte. 
 =SI(10<=M8<20;"Reçu";"Collé")    La double inégalité n'est pas autorisée. 
 

5.2.6 Nommer une cellule ou une plage de cellules 
Cette option permet de donner un nom à une cellule (ou une plage de cellules), nom qui pourra ensuite être 
utilisé à la place des références dans les formules de la feuille de calcul.  
 
Démarche à suivre : 
Sélectionner la cellule (ou la plage de cellules) souhaitée, 
Choisir la commande : menu Insertion → Nom → Définir… 
La référence de la cellule (ou de la plage de cellules) 
sélectionnée apparaît en bas de la boîte de dialogue « Définir un 
nom » 
Taper le nom souhaité dans la zone « Noms dans le classeur ». 
Attention : ne pas utiliser de caractères autres que des chiffres et 
des lettes, ne pas faire commencer le nom par des chiffres. 
Cliquer sur Ajouter, puis sur Fermer la boîte de dialogue « Définir un nom » 
Une fois qu’un nom a été défini pour une cellule (ou une plage 
de cellule), il apparaît dans la « Zone Nom » lorsque la cellule 
(ou la plage de cellules) correspondante est sélectionnée. 
 

Position de la « zone nom »
Dans notre exemple la zone a été nommée « ZoneNom » 

 
 
Inversement, pour sélectionner une plage de cellule qui a été préalablement nommée, il suffit de sélectionner 
le nom de plage correspondant dans la zone "Nom" de la fenêtre Excel.  
 

5.2.7 Visualiser l'ensemble des formules 
Normalement, dans les cellules contenant des formules, ce qui est affiché est le résultat de chaque formule. 
En choisissant de cocher l'option Outils -> Options -> Affichage -> Formules il est possible de faire 
afficher le libellé de toutes les formules de la feuille de calcul. 
 

5.2.8 Effacement de cellules 
Effacement des données plus le style d'une ou plusieurs cellules (préalablement sélectionnées) : 
     Edition -> Effacer -> Tout 
Effacement des données seules :  Edition -> Effacer -> Contenu 
Suppression d’une ou plusieurs cellules (avec décalage des cellules adjacentes) :  
     Edition -> Supprimer… 
 

5.3 Mise en forme de la feuille 
Mettre en forme une feuille, c'est changer les attributs visuels (police, style et taille des caractères, format 
des nombres, alignement, marges, taille des colonnes ou des lignes, etc ...). La plupart des commandes 
relatives à la mise en forme sont regroupées dans le menu Format, certaines commandes étant dupliquées 
par un bouton de la barre d'outils. 
 
� Pour modifier la largeur d'une colonne, ou la hauteur d'une ligne, la séélectionner en cliquant sur son en-
tête (lettre pour les colonnes ou nombre pour les lignes), puis faire glisser la limite à la souris (le curseur 
prend la forme d'une barre avec double flèche). Une autre solution consiste à utiliser les commandes Format 
-> Colonne -> Largeur… ou Format -> Ligne -> Hauteur… 
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� Pour définir les attributs au niveau des cellules, plusieurs possibilités existent. Dans tous les cas, il faut 
d'abord sélectionner les cellules concernées, puis : 
cliquer dans la barre d'outils sur l'icône correspondant à l'attribut désiré, 
ou bien choisir Format -> Cellule… qui fait apparaître une boîte de dialogue regroupant l'ensemble des 
attributs disponibles 
 
� Pour définir la police et le style de caractères utilisés, choisir 
l’onglet Police (figure ci-contre), puis l’attribut souhaité (par 
exemple Style Gras, Soulignement Simple). 
 
� Pour définir la précision et le format d'affichage des 
nombres, choisir l’onglet Nombre, puis éventuellement le 
nombre de décimales (par exemple, dans la catégorie ‘Nombre’ 
avec 2 décimales, les nombres 2,3 et 6,258 seront affichés sous 
la forme : 2,30 et 6,26 (mais la valeur exacte est conservée en 
mémoire).  
 
� Pour mettre un cadre (ou des traits de séparation entre les 
cellules), choisir l’onglet Bordure. 
 la boîte de dialogue Format de cellule 

(Onglet Police) 

5.4 Graphiques 
Pour créer un graphique : 
Sélectionner la plage de cellules contenant les données du graphique, choisir la commande Insertion -> 
Graphique… 
Suivre les indications de l’Assistant Graphique au cours des quatre étapes. A chaque étape, il est possible de 
revenir en arrière en cliquant sur < Précédent. Une représentation du graphique apparaît au fur et à mesure.  
Etape 1 sur 4 – Type de Graphique 
Choisir le type de graphique souhaité puis cliquer sur Suivant > 
Etape 2 sur 4 – Données source du graphique  
Une série est un ensemble de valeurs de même type, disposées dans des cellules adjacentes, en lignes (une 
valeur par colonne) ou en colonnes (une valeur par ligne). Les étiquettes (identifiables aux légendes lignes 
ou colonnes) permettent d'identifier chaque série de valeurs. 
Dans l'onglet Plage de données, vérifier que la plage de données 
sélectionnée précédemment apparaît. Définir la disposition des 
séries (en lignes ou en colonnes). 
 
Dans l'onglet Série, définir les étiquettes en sélectionnant les 
cellules correspondantes de la feuille de calcul. Puis sélectionner 
chacune des séries dans l'encadré de gauche et lui donner un nom 
dans la zone « Nom » sur la droite. 
Cliquer sur Suivant > 

la boîte de dialogue 
Données source du graphique

 (Onglet Série)
 
Etape 3 sur 4 – Options du graphique Suivant le type de graphique choisi à l'étape 1, il est possible de 
définir certains attributs : 
Titre du graphique 
Nom de l'axe des abscisses (X) 
Nom de l'axe des ordonnées (Y) 
Tracé des axes X et Y 
Choix de quadrillage 
Affichage de la légende et emplacement 
 
Cliquer sur Suivant > 
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Titre du graphique 
 
Tracé de l'axe Y 
 
Nom de l'axe des ordonnées 
 
 
 
 
 
 
Tracé de l'axe X 
Nom de l'axe des abscisses 

exemple de graphique 

 
Légende (en haut) 
 
 
Quadrillage 
 
Motif 
 
 
 

 
Etape 4 sur 4 – Emplacement du graphique 
Cette dernière étape permet d'insérer le graphique en tant que feuille séparée ou bien en tant qu'objet dans la 
même feuille de calcul (choisir cette seconde option). 
Pour valider le graphique, cliquer sur Terminer. 
 
Une fois le résultat du graphique apparu, il est possible de modifier certains aspects graphiques de la 
représentation obtenue en effectuant un double-clic sur le graphique, sur l’élément à modifier (graphique, 
légende, axes, libellés, etc...). Des boîtes de dialogues permettent de modifier ces éléments. 

5.5 Macros 
Une macro est un enregistrement de commandes que l'on peut ensuite réutiliser. Les commandes de la macro 
sont automatiquement écrites sous la forme d'un programme, qu'il est possible d'éditer. Le langage utilisé par 
Microsoft Office est le Visual Basic Application (VBA). 
 

5.5.1 Enregistrement d’une macro  
Avant de commencer l’enregistrement, Excel doit être ouvert sur 
un classeur, de préférence vide. 
Pour démarrer l’enregistrement d’une macro : menu Outils → 
Macro → Nouvelle macro. La boîte ci-contre apparaît. Par 
défaut, la macro s’appelle ‘Macro1’, renommez-la d’un nom plus 
explicite et cliquez sur OK. . Ne changez pas le lieu 
d’enregistrement de la macro ‘Ce classeur’. Le fait d’avoir 
enregistré la macro dans ce classeur implique toute une série de 
conséquences. Pour le moment, sachez que ce choix lie votre 
macro au classeur ouvert. 
 
A partir de maintenant, vous êtes en mode d’enregistrement de la macro. Tapez ou réalisez les éléments 
souhaités, sans vous tromper : toutes les opérations que vous faites sont enregistrées. 
 
Pour arrêter l’enregistrement d’une macro, il vous suffit de retourner dans le menu Outils → Macro. Le 
menu affiché s’est modifié et vous propose maintenant d’arrêter l’enregistrement. 
Une autre méthode plus rapide est possible. Lorsque vous avez commencé l’enregistrement de la 
macro, une icône « arrêt de l’enregistrement » est apparue (il se peut qu’elle n’apparaisse pas, 
cela dépend de la configuration du logiciel, dans ce cas utilisez la méthode précédente). Un 
simple clic sur le carré bleu permet de suspendre l’enregistrement. 
Attention : si vous cliquez sur la case de fermeture dotée d’une croix, vous allez fermer cette mini-fenêtre, 
mais vous n’arrêterez pas l’enregistrement de la macro. 
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5.5.2 Exécution d'une macro  
Avant de commencer l’exécution de macros 
précédemment enregistrées, Excel doit être 
ouvert sur une feuille vide.  
Pour exécuter une macro : 
Sauvegardez, 
Menu Outils → Macro → Macros … ou ALT 
F8 
Dans la boîte de dialogue qui apparaît (reproduite 
ci-contre) sélectionner la macro à exécuter (s’il 
n’y a qu’une macro, la sélection est automatique), 
puis cliquez sur le bouton « Exécuter »  
Vous allez voir les diverses actions de la macro 
se dérouler dans l’ordre exact où vous les avez 
enregistrées. 

Remarquez qu'au nom de la macro est associé le nom du classeur qui était actif lors de 
l'enregistrement des macros. 
 

5.5.3 Observation et édition du code d’une macro  
Pour observer ou éditer le code d’une macro procédez tout d’abord comme pour l’exécution : 
Menu Outils → Macro → Macros … ou ALT F8 et sélectionnez la macro à éditer. 
Cliquez sur le bouton « Modifier ». Une nouvelle fenêtre s’ouvre alors, c’est l’éditeur de Visual Basic 
Applications (VBA). 
La compréhension du langage de Visual Basic permet, entre autres, de corriger d’éventuelles erreurs 
d’enregistrement dans votre macro et d’automatiser simplement certaines tâches. 
L’éditeur se manipule comme un document Word, nous avons ajouté les spécificités principales sur le schéma 
présenté ci-après.  
Une fois vos modifications effectuées, sauvegardez, et revenez dans l’environnement feuille de calcul en 
cliquant sur le bouton à l’extrémité gauche de la barre d’outils. 
 

 
 

5.5.4 Les styles de référence A1 et L1C1 (R1C1) 
Style de référence A1 : 
Par défaut, Excel utilise le style de référence A1 qui étiquette les colonnes à l'aide de lettres (de A à IV, pour 
couvrir 256 colonnes) et les lignes à l'aide de numéros (de 1 à 65536). Ces lettres et numéros portent le nom 
d'en-têtes (ou indicateurs) de ligne et de colonne. Pour faire référence à une cellule, entrez la lettre de la 

Lance l’exécution 
d’une macro 

Permet de passer d’une 
macro à l’autre 

Retour vers 
l’environnement Excel 
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colonne suivie du numéro de la ligne. Par exemple, B2 fait référence à la cellule située à l'intersection de la 
colonne B et de la ligne 2. 
 
Style de référence L1C1 (R1C1) : 
Lorsque vous enregistrez une macro, Excel enregistre certaines commandes à l'aide du style de référence 
L1C1. Si, par exemple, vous enregistrez une commande en cliquant sur le bouton Somme automatique en 
vue d'insérer une formule qui totalise une plage de cellules, Excel enregistre la formule à l'aide de références 
L1C1 et non A1. 
 
Visualisation des styles : 
On peut choisir le mode de visualisation des en-têtes (indicateurs) de lignes et colonnes en fonction du style 
de référence. Pour ce faire aller dans : 
menu Outils → Option… cliquer sur l’onglet : « Général »  et choisir : choix « style de référence L1C1 ». 
Lorsque ce choix est désactivé la fenêtre Excel apparaît affichée dans le système A1, sinon c’est le système 
L1C1 qui est validé. 
 
Référence aux cellules dans le style de référence R1C1 : 
Nous utiliserons ce style de référence lorsque nous développerons des macros. 
  

L[-2]C Référence relative à la cellule située deux lignes au-dessus de la cellule active et dans la même 
colonne 

L[2]C[2] Référence relative à la cellule située deux lignes en dessous de la cellule active et deux colonnes à 
droite 

L2C2 Référence absolue à la cellule située sur la deuxième ligne et dans la deuxième colonne 
L[-1] Référence relative à toute la ligne située au-dessus de la cellule active 
L Référence relative à la ligne en cours 
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6 Internet Explorer 
 
Internet Explorer est un logiciel permettant de naviguer sur le web et d’afficher des pages web à 
l’écran. Il existe de nombreux logiciels qui permettent de faire la même chose. On appelle ces 
logiciels des "butineurs" ou des "navigateurs" (ou "browsers" en anglais).  
 
Version utilisée au DLST : Microsoft Internet Explorer 6 
 

6.1 Démarrage et interface 

 → Programmes → Internet Explorer ou   cliquez sur l’icône : 
 

 
  Barre de titre    Rappel des adresses précédentes 
 
Barre des menus 
 
Barre d’outils 
 
Zone de saisie d’URL 
(ou champ d’adresse) 
 

 
 
   
 
Pour accéder à une page web particulière du réseau Internet, il faut soit indiquer son adresse (URL) dans le 
champ d’adresse, soit disposer dans la zone d’affichage du lien approprié et cliquer dessus.  
Il est possible d’enregistrer les pages web que l’on visite sur son espace disque, ou inversement d’afficher 
des pages web préalablement enregistrées sur son espace disque : celles que vous aurez éventuellement 
récupérées sur Internet, mais surtout celles que vous aurez rédigées en html avec un éditeur comme « Bloc-
notes » ou « WebExpert ».  
 

6.2 Enregistrer une page web sur 
votre espace disque. 

• Ouvrez le menu Fichier 
• Cliquez sur "Enregistrer sous…" 
• La fenêtre ci-contre s’ouvre 
• Sélectionnez le disque Z : (home sur 

'sarado'), puis le répertoire souhaité  
• Dans la partie Nom, remplacez le nom 

proposé par défaut par le nom de fichier 
souhaité 

• Cliquez sur le bouton Enregistrer 
 

Zone d’affichage 
de la page web 
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6.3 Ouvrir (afficher) une page web de l’espace disque  
Il s’agit ici d’afficher une page, qui n’est pas sur Internet, 
mais sur votre espace disque. Par exemple, une page que 
vous venez de construire.  

• Ouvrez le menu Fichier 
• Cliquez sur « Ouvrir » 
• La fenêtre ci-contre s’ouvre. 
• Cliquez sur le bouton Parcourir 
• La fenêtre classique de recherche de fichiers sur 

l’espace disque (ci-dessous) s’ouvre alors. 
 

 

• En cliquant sur le bouton muni d’un 
triangle noir à droite du nom de répertoire, 
vous allez faire apparaître la liste des 
mémoires de masse et des répertoires : 

 

 
 
• Sélectionnez le disque Z : (home sur 

'sarado'). S’il n’apparaît pas, cliquez sur 
« bureau » au sommet pour le retrouver. 

• Sélectionnez le(s) répertoire(s) ou 
dossier(s) approprié(s), puis le fichier à 
ouvrir. 

• Cliquez sur le bouton Ouvrir 
 

6.4 Enregistrer une image du web sur votre espace disque 
 
• Placez le pointeur de la souris sur l’image à enregistrer 
• Cliquez avec le bouton droit de la souris. Le menu flottant contextuel  

ci-contre apparaît. 
• Sélectionnez Enregistrez l’image sous … 
• La fenêtre classique (ci-dessous) de rangement de fichiers sur l’espace 

disque s’ouvre alors. 
• En cliquant sur le bouton muni d’un triangle noir à droite du nom de 

répertoire, vous allez faire apparaître la hiérarchie des répertoires : 

 
 

 
• Sélectionnez le disque Z : (home sur 'sarado'). S’il 

n’apparaît pas, cliquez sur « bureau » en haut de liste 
pour le retrouver. 

• Sélectionnez le répertoire ou dossier approprié pour 
l’enregistrement. 

• Modifier éventuellement le nom de fichier qui vous 
est proposé par défaut dans la zone « Nom ». 

• … et spécifier le format de fichier désiré dans la zone 
« Type ». 

• Cliquez sur le bouton Enregistrer 
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6.5 Enregistrer sur votre espace disque un fichier autre qu’une page 
web (Word, Excel, …) 

• Placez le pointeur de la souris sur le nom du fichier à enregistrer 
• Cliquez avec le bouton droit de la souris. Le menu flottant contextuel présenté au paragraphe précédent 

apparaît. La démarche est ensuite identique à celle qui a été décrite pour enregistrer une image du web. 
 

6.6 Afficher le code html de la page web consultée 
Menu Affichage, puis Source 
Le code source html de la page web est visible dans une fenêtre de l’éditeur Bloc notes. 
Il se peut que le contenu de la page soit difficilement lisible du fait d’une longueur de ligne excessive en 
dehors des limites de l’écran. Pour pallier à ce problème modifier les conditions d’édition :  
Menu Edition → Retour à la ligne automatique. 

7 Mozzila Firefox 
 
Mozzila Firefox est un autre logiciel permettant de naviguer sur le web et d’afficher des pages web à 
l’écran.  
 
Version utilisée au DLST : Mozzila Firefox 1.5 
 
Les fonctionnalités offertes par Mozzila Firefox sont sensiblement les mêmes que celles offertes par Internet 
Explorer. Les menus sont assez similaires. A noter, par défaut au DLST, l’interface de Mozzila Firefox 
comporte, dans la barre de navidagtion, un champs permettant de faire directement des recherches sur 
Google. 
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8 Bloc notes 
 
Bloc-note est un éditeur de texte, c’est à dire un petit programme qui permet de visualiser et de modifier des 
textes simples, sans mise en forme. Il est livré en standard avec Windows NT, et est tout à fait adapté, par 
exemple, pour éditer un fichier html si WebExpert n’est pas disponible. 
 

8.1 Lancer le programme : 
 → Programmes → Accessoires → Bloc Notes 

 

8.2 Sauvegarder le fichier édité : 
• Ouvrez le menu Fichier 
• Cliquez sur "Enregistrer sous…" 
• La fenêtre ci- dessus s’ouvre 
• Sélectionnez le disque Z : (home sur 'sarado'), puis le répertoire souhaité (1) 
• Dans la partie Nom de fichier, inscrivez le nom souhaite (2) 

Cliquez sur le bouton Enregistrer 
 

8.3 Quitter le programme Bloc-notes : 
• Ouvrez le menu Fichier 
• Cliquez sur Quitter 

 

9 Notepad++ 
 
Notepad++ est un autre éditeur de texte, disponible au DLST.  
 
Notepad++ est particulièrement adapté pour editer du code source.  
Notepad++  supporte plusieurs langages, parmi lesquels HTML, Java et VB. Dans le menu langage, on peut 
spécifier dans quel langage on écrit le code source (HTML, Java, …). L’affichage du contenu du fichier est 
alors adapté pour faire apparaître d’une certaine couleur, les mots clef spécifiques au langage choisi.   
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10  WebExpert 
 
WebExpert est un logiciel d’édition spécialisé de pages web. Il permet non seulement de taper le code html 
(ce que fait n’importe quel simple éditeur de texte comme Bloc notes), mais surtout possède une vaste 
bibliothèque de ressources html prêtes à l’emploi qui facilite grandement la réalisation de pages web. 
 
Version utilisée au DSU : WebExpert 5  

10.1 Lancer WebExpert  

 → Tous les programmes → WebExpert 5 → WebExpert 5 ou bien double-cliquez sur l’icône 
représentant WebExpert. 

10.2 Interface 
L’interface de WebExpert (WE) est organisée en trois parties (voir figure ci dessous) : 
 
 Barre de titre Barres des outils Barre des menus  Onglets 
 

 organisation générale de l’interface utilisateur de WebExpert 
 
• La zone de commandes comporte  
� Les barres des menus et des outils qui permettent (entre autres) de gérer la sauvegarde et la lecture 

de fichiers (menu Fichier)  
� La barre des onglets qui est le lieu des ressources html. Chaque onglet correspond à une barre 

d’outils dont les boutons permettent d'insérer le code (=texte) des balises html (cf § 8.5.1) dans la 
zone d’édition. Ces outils sont classés par thèmes dans des onglets (Communs, Spécialisés …).  

• La fenêtre source contient le code HTML (code source) de la page en cours d'édition. Elle fonctionne 
comme un éditeur de texte (tel l’éditeur "Bloc-Notes") ouvert sur le fichier source : ce dernier est 
librement modifiable à tout moment par l'utilisateur. 

Zone de 
commandes 

Fenêtre source : 
zone d’édition 

du code html de 
la page Web 

Inspecteur  
de code 
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• L'inspecteur de code permet de choisir et d’ajouter des paramètres aux balises de la page html en cours 
d’édition. 

10.3 Opérations sur les fichiers 
 

10.3.1 Créer une nouvelle page  
Menu « Fichier » puis « Nouveau » 
ou « CTRL »+ « n »  
ou le bouton  de la barre d’outils. 
Pour la réalisation d’une page Web, choisir : 
document HTML 
Pour la réalisation d’une feuille de style, choisir 
Document CSS 
 

10.3.2  Ouvrir un fichier préexistant 
• Menu « Fichier » puis « Ouvrir »,  

ou « CTRL » + « o »),  
ou le bouton  de la barre d’outils. 
• Recherchez le disque Z. : pour cela, utilisez le 

menu déroulant associé au champ « Regarder 
dans » (bouton muni d’un triangle noir), puis le 
répertoire contenant le fichier à ouvrir. 

• Sélectionnez le fichier voulu. 
• Cliquez sur le bouton Ouvrir. 

Dans la fenêtre d’édition, WE va afficher le contenu 
du fichier html sélectionné, c’est à dire le code 
HTML (ou source) de la page Web Exemple.html 

10.3.3  Ouvrir plusieurs documents à la fois 
On peut ouvrir plusieurs documents à la fois selon la démarche décrite précédemment. 
Seul un document sera affiché dans la zone d’édition, mais on passe facilement d’un document ouvert à 
l’autre par les onglets qui bordent la partie supérieure de la fenêtre. 

Fichiers ouverts mais non affichés          Fichier affiché dans la zone d’édition 
Lorsqu’une disquette apparaît à coté du nom indiqué sur l’onglet, cela signifie que le fichier a été modifié 
sans être enregistré.   
 

10.3.4  Sauvegarder (enregistrer) un fichier pour la première fois 
• Menu « Fichier » puis « Sauvegardez sous… » 

Par défaut, vous vous trouvez dans le dossier Personnel, créé dans Crip (C :)  
Ne jamais sauvegarder sur le disque dur interne de votre PC, appelé « Crip (C :) ».  
Le seul espace disque qui vous est réservé est « home sur sarado  (Z :)». Tous les autres endroits sont 
régulièrement effacés par la maintenance, et ce, sans préavis. Il faut donc toujours sauvegarder les 
informations sur le serveur commun qui porte le nom « home sur sarado  (Z :)» 
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• Recherchez le disque home sur sarado (Z:). : 

pour cela, utilisez le menu déroulant associé au 
champ « Regarder dans » (bouton muni d’un 
triangle noir), puis le répertoire dans lequel on 
veut enregistrer le fichier courant. 

• Donnez un nom à votre fichier dans le champ 
« Nom de Fichier » 

• Cliquez sur le bouton « Sauvegarder » 
 

10.3.5  Sauvegardes ultérieures  
Si vous avez déjà enregistré votre fichier selon la démarche précédente, il n’est pas nécessaire de refaire 
intégralement la procédure pour sauvegarder : cliquez simplement sur le bouton  de la barre d’outils, ou 
utilisez le raccourci clavier CTRL+S, ou encore menu Fichier → Sauvegarder. 
 

10.3.6  Copie de document à partir de WE 
Vous souhaitez faire une copie d’un document html déjà ouvert avec WebExpert. Pour cela, il suffit de 
sauvegarder votre document normalement, puis le sauvegarder une deuxième fois sous un nouveau nom. 
Seule la copie avec le nouveau nom sera affichée par WE, mais le premier document avec l’ancien nom est 
conservé sur votre espace disque et peut être ouvert lui aussi avec WE. 
Une telle démarche est possible avec tout logiciel utilisé au cours de cette année. 
 

10.4 Visualiser la page Web associée à un code html 
Par « visualiser la page », on entend observer non pas le source HTML de celle-ci, mais l’affichage produit 
lorsque ce source est interprété par un butineur, par exemple IE (Internet Explorer). 
Il y a 2 possibilités : 
 
• 1 - avec le navigateur interne de WebExpert : utiliser le menu outils puis lancer le navigateur 

interne ou la touche de fonction <F12>. Le navigateur interne affiche la page Web correspondant au 
source HTML en cours, que celui-ci ait été enregistré ou non.  

Attention : Ce navigateur est rapide et pratique pour visualiser la page en cours, mais il n'est pas 
toujours adapté pour vérifier le fonctionnement d'un site avec des liens multiples. 
 
• 2 - avec Internet Explorer : lancer Internet Explorer, puis utiliser le menu Fichier puis Ouvrir. Cliquez 

sur Parcourir pour accéder aux fichiers de votre espace disque (Z:Home sur Sarado).  
Attention : pour que le résultat affiché par Internet Explorer corresponde à votre code source HTML 
il a nécessaire : 

- d'une part que le source HTML correspondant ait été préalablement enregistré,  
- d'autre part que la page Web soit remise à jour, 

o soit par une pression de la touche de fonction <F5>, 

o soit par un clic sur l'icône « actualiser »  de Internet Explorer 
o soit par le menu Affichage → Actualiser. 

 

10.5 Insérer des balises - modifier une page. 
Un des fondements de base du langage HTML, l’élément permet de définir le type d’action ou de traitement 
à appliquer sur un contenu visé. L’élément est toujours compris entre des crochets < >, on appelle alors cet 
ensemble balise. L’action ou le traitement appliqué par un élément peut-être nuancé par des attributs, inclus 
eux aussi dans les balises. Dans ce qui suit est expliqué comment utiliser WebExpert pour manipuler 
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facilement ces éléments de HTML. Un récapitulatif des principales balises de HTML et leurs attributs est par 
ailleurs donné « Chapitre 12 : Lexique HTML » de ce guide. 

10.5.1  Méthode générale pour insérer des balises 
Voyons comment insérer des balises. Dans la partie inférieure de la zone de commandes, une série d'onglets 
regroupe des boutons permettant d'insérer des balises dans le code html. Ces onglets regroupent les balises 
par thèmes. Les fonctions des boutons des onglets sont également accessibles par le menu « Onglets ». 
 
Il y a deux manières d'utiliser la plupart des balises. Par exemple, nous allons insérer les textes « texte1 » et 
« texte2 » dans votre page html et les mettre en gras et en italique. 
 

Syntaxe html : <b> <I> texte </I> </b> 
 

• Manière 1 :  
- Placez le curseur à l’endroit voulu et tapez « texte1 » 
- Sélectionnez « texte1 » à la souris (double-clic gauche sur le mot) le texte « texte1 » doit apparaître 

en blanc sur fond noir (inverse vidéo),  
- cliquez successivement sur les balises Gras  et Italique  de l'onglet Communs  

Quand on laisse le pointeur de la souris sur une icône, WE nous affiche une étiquette qui permet de 
connaître la fonction de l’outil. Dans la fenêtre d’édition, le code html correspondant à «gras » et 
« italique » a été ajouté : <b><i>texte1</i></b> 

- visualisez le résultat avec un butineur (cf § 8.4). 
• Manière 2 :  

- placez le curseur à l’endroit où vous voulez insérer ce « texte2 », 
- cliquez successivement sur les balises Gras et Italique puis tapez le « texte2 », 
- visualisez le résultat avec un butineur (cf § 8.4). 

 
L'édition directe du code source HTML, en tapant soi-même les dans la fenêtre d’édition (comme on 
pourrait le faire avec l’éditeur Bloc notes) est également possible. Elle nécessite une connaissance 
précise du langage HTML mais peut être nécessaire dans certains cas. 
 

10.5.2  Balises de mise en forme courantes : onglet « communs » 
   Centrage alignements gauche et droit (boutons de défilement des onglets) 
 

 
 
Taille de police  gras    souligné paragraphe   couleur de la police 
 Taille de titre      italique   retour à la ligne 
 

10.5.3  Insérer un lien 
Un lien est un texte cliquable permettant d’accéder à une nouvelle page. 
 

Syntaxe html : <A HREF="adresse cible"> texte du lien </A> 
 
1. Sélectionner à la souris le texte qui deviendra cliquable.  

2. Dans l'onglet Spécialisés, cliquer sur le 6ème icône , qui correspond à la création d'un lien externe. 
Une fenêtre « Lien externe » permettant de saisir le lien apparaît (voir ci-dessous). 

3. Dans cette fenêtre ainsi ouverte, sélectionner lien direct comme type de lien. 
4. Utiliser le bouton de parcours du disque  pour localiser le fichier contenant la page html cible du 

lien, la fenêtre « Ouvrir fichier » apparaît alors (voir ci-dessous). Alternativement, il est possible de 
taper directement le nom du fichier et son éventuel chemin d’accès (adresse cible) directement dans la 
zone de saisie Référence à un lien externe. 

5. Valider en cliquant sur OK. Dans la fenêtre d’édition, le code HTML correspondant au lien a été ajouté. 
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6. Visualiser le résultat à l’aide d’un butineur (cf § 8.4) et testez le fonctionnement du lien ! 

   
 

10.5.4  Insérer une image 
Syntaxe html : <IMG SRC="image"  ALIGN="attribut" height=xx width=yy> 

 
1. Positionnez le curseur à l’endroit où vous voulez que l’image apparaisse. 

2. Dans l'onglet spécialisés de WE, cliquer sur la 3ème icône , qui correspond à l'insertion d'une image. 
Une fenêtre intitulée Insérer une image graphique doit apparaître. 

3. Dans cette fenêtre, cliquer sur le dossier 
jaune  situé à droite du champ de 
saisie image. Une fenêtre similaire à 
l’explorateur Windows dans son 
fonctionnement apparaît. Elle vous 
permet de parcourir le système de 
fichiers de votre ordinateur et de 
sélectionner graphiquement le fichier 
correspondant à l’image devant être 
affichée. 

Remarque : pour « ouvrir » un dossier, 
double cliquer dessus. 
4. Sélectionner le fichier correspondant à 

l’image souhaitée et cliquer sur le bouton 
Ouvrir (ou tout simplement double 
cliquer sur le fichier). 

5. Vous pouvez modifier l’alignement, la 
taille, ou la bordure, ou laisser les valeurs 
qui sont proposées par défaut. 

6. Cliquer sur OK. 
7. Dans la fenêtre d’édition, le code HTML correspondant à l’affichage de l’image a été ajouté. 

<IMG SRC="image"  ALIGN="attribut" height=xx width=yy> 
8. Visualiser le résultat à l’aide d’un butineur (cf § 8.4). Si l’alignement ou les dimensions ne vous 

conviennent pas, vous pouvez modifier le code html introduit directement dans la fenêtre d’édition de 
WE. 

 

10.5.5  Insérer un lien sur une image (image cliquable) 
Une image cliquable, c’est une image sur laquelle on met un lien. Un clic sur l’image permet donc d’accéder 
à une nouvelle page. 
 
Syntaxe html :  

<A HREF="adresse cible"> <IMG SRC="image" ALIGN="attribut" height=xx width=yy> </A> 
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Du point de vue de la syntaxe html, le texte du lien est simplement remplacé par le code html de l’image. 
 
• Insérer une image selon la méthode décrite précédemment. 
• Sélectionner à la souris le code html correspondant à l'image précédemment insérée.  
• Insérer un lien selon la méthode décrite plus haut (points 2 à 5) 
• Visualiser le résultat à l’aide d’un butineur (cf § 8.4). et testez le fonctionnement du lien ! 
 

10.5.6 Tableau 
 
Les tableaux permettent d’aligner du texte et des 
nombres. Ils sont également très utiles pour aligner 
ou mettre en place des images. 
 
Exemple : 

 

Syntaxe html :  
<table border=1> 
    <tr> 
      <td> cellule11 </td>  
      <td> cellule12 </td> 
    </tr> 
    <tr> 
      <td> cellule21 </td> 
      <td> cellule22 </td> 
    </tr> 
</table> 

 
Pour ajouter un tableau dans votre page Web : 
• Placez le curseur à l’endroit voulu dans le code 

html de votre page. 
• Dans l’onglet « tableaux, cadres et listes », 

cliquer sur le bouton « insérer un tableau » 

 
 

 

 
Une boîte de dialogue « insérer un tableau » 
apparaît, demandant d’indiquer le nombre de lignes 
et de colonnes, faites votre choix et validez par Ok. 
La fenêtre « Tableau » ci-contre suit alors : 
• Pour que les contours des cellules du tableau 

apparaissent, n’oubliez pas de mettre une valeur 
d’au moins 1 à « border ». 

• La partie « esquisse » permet de rentrer le texte 
ou le code html à faire figurer dans les 
différentes cellules du tableau. 

• Cliquez sur OK. Dans la fenêtre d’édition, le 
code HTML correspondant à l’affichage du 
tableau a été ajouté. 

 
Pour modifier les paramètres du tableau, vous pouvez revenir à la fenêtre « tableau » : 

i) en sélectionnant le code html du tableau dans la fenêtre d’édition (<table> .. </table>) 
puis en cliquant sur le bouton « insérer un tableau » de l’onglet « tableaux, cadres et listes », 

ii) en cliquant sur la balise <table> et en utilisant les facilités de l’inspecteur de code (fenêtre de 
gauche – voir § suivant), 

iii) en ajoutant de nouvelles balises directement dans le code html de votre page Web (fenêtre 
d’édition de WebExpert). 

 

10.6 Ajouter des attributs aux balises à l’aide de l’inspecteur de code 
Les attributs des balises permettent de personnaliser certains éléments : par exemple, mettre une couleur de 
fond particulière à une page Web se fera par l’intermédiaire de l’attribut « bgcolor » appliqué à la balise 
« body ». Le même attribut permet de colorer également un tableau, une ligne ou une cellule de tableau. 



UJF Licence Sciences – INF 112 Guide  

57 

 
Syntaxe html (exemple sur la balise body) : <body bgcolor=#AABBCC> 

où la valeur AABBCC est le code de la couleur choisie. 
 
L’inspecteur de code (fenêtre de gauche de WE ou menu Afficher → Afficher l’inspecteur de code ou 
MAJ+F6) (onglet propriétés ) permet d’ajouter facilement n’importe lequel des attributs permis d’une balise 
donnée. Il donne aussi la liste des attributs possibles pour une balise particulière. 
 
Démarche à suivre : 
• Dans la fenêtre d’édition du code html, placez le curseur dans la balise à 

personnaliser. Pour notre exemple de couleur de fond de la page web, 
cliquez sur la balise <body> : . L’inspecteur de code (onglet 
propriétés) affiche alors la liste de tous les attributs possibles pour cette 
balise. 

• Dans cette liste, cliquer sur l’attribut souhaité. Pour notre exemple, cliquez 
sur bgcolor. 

• A droite de l’attribut apparaissent en général un ou deux boutons, munis d’un triangle ou de 3 points. 
Ces boutons indiquent un menu (triangle) ou une palette (…) dans lequel choisir la valeur de l’attribut. 
Pour notre exemple, cette valeur correspond à la couleur que l’on veut pour notre page 

• Choisir une valeur. Dans la fenêtre d’édition, le code 
html de l’attribut et de sa valeur a été ajouté à la 
balise. 

• Visualisez le résultat sur la page Web à l’aide d’un 
butineur. 

 

Menu des couleurs

Palette des couleurs 
 
 

10.7 Les feuilles de style (cascading style sheet ou css) 
Les feuilles de styles permettent de définir des styles plus étendus que les simples attributs de balises, et 
surtout une même définition de styles peut porter sur plusieurs pages différentes d’un site. L’effet des balises 
peut être modifié ou redéfini dans un fichier externe à la page html. Ce fichier (par exemple styletoto.css) 
doit se terminer par l’extention .css et être relié à la (ou les) page(s) html sur laquelle (lesquelles) il 
s’applique par l’instruction : 
<link rel="StyleSheet" href="styletoto.css" type="text/css"> 
à placer entre les balises <HEAD> </HEAD>  de l’entête de la page html. 
 
 

10.7.1  Créer une nouvelle feuille de style  
Menu « Fichier » puis « Nouveau » 
ou « CTRL »+ « n »  
ou le bouton  de la barre d’outils. 
Parmi les icônes de nouveaux documents proposés, choisir Document 
CSS 
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10.7.2  Ouvrir une feuille de style préexistante 
 
La procédure est la même que pour un fichier html 
(cf 8,3,2). Toutefois, dans la fenêtre d’ouverture 
(reproduite ci-contre) il faut vérifier que dans « type 
de fichier » on a bien « tous les fichiers ». Sinon, il se 
peut que seuls les fichiers en .html apparaissent dans 
la liste, et pas les fichiers en .css. 

10.7.3  Définir des styles 
Syntaxe css (exemple de fichier) :  

 
body { 
 background: #000000; 
 color: white; 
 font-family: “Times”, serif; 
 text-align: justify; 
 line-height: 1.3; 
 margin-left: 20%; } 
 
h2 { 
 text-align: right; 
 font-size: larger; 
 font-weight: bold; 
 text-transform: uppercase; } 
 
.acronyme {  
 background: blue;  
} 

Effet sur la page Web 
 
Sur la page entière :  
 Fond noir 
 Texte blanc 
 Police Times, ou de famille sérif 
 Alignement du texte des 2 cotés 
 Hauteur de ligne 
 Marge gauche : 20% de la largeur de la page 
 
Sur les sous-titres repérés par la balise <h2> : 
 Texte aligné à droite 
 Caractères plus larges que le standard. 
 Caractères en gras 
 Caractères en majuscules 
 
Sur le texte marqué par une balise quelconque portant 
l’attribut class="acronyme" : 
 fond bleu 

Plus de styles sont décrits dans ce document, dans la partie « propriété des styles css » . 
 
L’inspecteur de code (fenêtre de gauche de WE ou menu Afficher → Afficher l’inspecteur de code ou 
MAJ+F6) (onglet styles) permet d’ajouter facilement n’importe lequel des styles permis d’une balise 
donnée. Il donne aussi la liste des styles possibles pour une balise particulière. 
Démarche à suivre : 
• Dans la fenêtre d’édition du code css, tapez le nom de la balise pour laquelle on souhaite appliquer un 

style, suivie d’accolades {}. Par exemple  h1 {}. 
• placez le curseur entre les lettres de la balise à personnaliser. L’inspecteur de code (onglet Styles) affiche 

alors la liste de toutes les propriétés de style possibles pour cette balise. 
• Dans cette liste, cliquer sur le style souhaité. Pour notre exemple, cliquez sur background 
Un menu apparaît dans lequel on peut faire son choix. Le style est alors ajouté (ou modifié s’il y avait déjà 
cette propriété de style) entre les accolades. 
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11  GIMP 
 
Gimp est l’acronyme de GNU Image Manipulation Program (Programme de manipulation d’image GNU). Il 
s’agit d’une suite logicielle pour des tâches concernant la retouche photo, la composition d’images et la 
fabrication d’images. GIMP est un logiciel gratuit qui peut être téléchargé sur www.gimp.org. Un manuel 
complet est accessible sur : //manual.gimp.org/. 
 
Version disponible au DLST : 2.2 
GIMP est un logiciel gratuit qui peut être téléchargé à partir du site : www.gimp.org 

11.1 Interface : fenêtre principale et autres …. 
Lancez le GIMP  
Démarrer → Tous les programmes → Gimp pour Windows → The Gimp, ou bien en cliquant sur 
l'icône  du bureau.  
 
Lors de la première utilisation sur votre 
environnement personnel, GIMP va s’installer 
automatiquement. Suivez les consignes en cliquant sur 
« OK » ou « Continuer » 
. 
Cela va ouvrir une fenêtre principale « The Gimp Pack 
Mode », à l’intérieur de laquelle on trouve deux sous-
fenêtres qui contiennent les différents sous-menus, 
parmi lesquels :  
• la palette d’outils,  
• les options des outils,  
• la sélection du pinceau et des calques. 
 
Il est possible de faire apparaître d’autres fenêtres 
selon les besoins (ou faire revenir celles que vous 
aurez fermées) en activant la commande :  
menu Fichier Æ Dialogues  
 
 

11.1.1  Accès aux commandes 
Dans Gimp, vous pouvez accéder aux commandes 
plusieurs façons différentes : 
- soit cliquer sur les menus Fichier, Exts, Aide dans 

la fenêtre principale du logiciel, 
- soit cliquer avec le bouton droit de la souris dans 

l'image que vous éditez, ce qui fera apparaître un 
menu flottant. 

- Soit cliquer sur la flèche  en haut à gauche de 
l'image que vous éditez. 

Vous aurez ainsi accès à différents menus, dont les commandes se recoupent partiellement. 

11.1.2  Quitter GIMP 
On quitte GIMP par la commande Fichier -> Quitter, ou simplement en cliquant sur la case de fermeture de 
la fenêtre principale. Attention donc à ne pas fermer celle-ci par accident ! 
 

11.2 Taille et type des fichiers 
Gimp peut supporter un grand nombre de formats de fichier, tout dépendra des plug-ins que vous avez 
installé. Un grand nombre de fonctions dans Gimp repose sur les plug-ins. Par exemple, nous pouvons 
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trouver des plug-ins pour envoyer nos images par mail, pour les imprimer, et bien sûr pour différents filtres 
de formats de fichier. 
La liste qui suit décrit les formats de fichier que peut lire et/ou écrire Gimp. Nous détaillons les plus usuels. 
 

Format  Lecture  Ecriture  Format  Lecture  Ecriture  
Bmp  X  X  Png  X  X  
Cel  X  X  Pnm  X  X  
Fits  X  X  Psd  X   
FaxG3  X   Postscript  X  X  
Gbr  X  X  Sunras  X  X  
Gif  X  X  Snp  X   
Gicon  X  X  Tga  X  X  
Hrz  X  X  Tiff  X  X  
Header   X  Url  X   
Jpeg  X  X  Xcf  X  X  
Pat  X  X  Xwd  X  X  
Pcx  X  X  Xpm  X  X  
Pix  X  X  Gzip  X  X  
 
Bmp: C'est un format bitmap non-compressé qui est utilisé dans Microsoft Windows pour afficher les 
images. La profondeur des couleurs est généralement de 1, 4 ou 8 bits, mais ce format peut en supporter 
davantage. 
Gif: Graphics Interchange. Les images GIF sont en couleurs indexées 8 bits et peuvent être transparentes. 
Elles peuvent être également chargées en interlacé (graduellement) par quelques programmes. Le format GIF 
supporte également les animations et les commentaires. 
Jpeg: Ce format supporte la compression et toutes les profondeurs de couleurs. La compression de l'image 
est ajustable, mais attention: une compression trop importante causerait des dommages à la qualité de 
l'image: la compression Jpeg est une compression avec pertes. Jpeg est l'acronyme de Joint Photographics 
Experts Group. 
Png: C'est le format de fichier supposé remplacer le format GIF et ainsi résoudre les problèmes de droits 
d'auteur. Les images en Truecolor, en couleurs indexées et en niveaux de gris sont acceptés. Le format Png 
utilise une compression, mais à l'inverse du format Jpeg, il n'y a pas de pertes d'information dans l'image. 
Png est l'acronyme de Portable Network Graphics. 
Psd: Ce format n'est utilisé que par Adobe Photoshop. 
Postscript: Il s'agit d'un langage de description de page qui est très utilisé par les imprimantes et autres 
organes de sorties. Le format Postscript est un excellent moyen de distribuer des documents. Ce format fut 
créé par Adobe. 
Tiff: Acronyme de Tagged-Image File Format, le Tiff est un standard de l'industrie de l'image. Il existe de 
nombreuses variations du format Tiff. Sachez qu'il supporte six routines d'encodage différentes et trois 
modes d'images: noir & blanc, niveaux de gris ou en couleurs. Le Tiff sans compression supporte 1, 4, 8 ou 
24 bits par pixel. Le Tiff compressé au format LZW supporte 4, 8 ou 24 bits par pixel. 
 

11.3 Opération sur les fichiers (nouveau, ouvrir, enregistrer) 
Accéder au menu fichier : 
- par le menu Fichier dans la fenêtre principale du logiciel, 
- par le bouton droit de la souris dans l'image que vous éditez, ce qui fera apparaître un menu flottant 

comprenant la commande « Fichier ». 
- par la flèche  en haut à gauche de l'image si vous éditez une image 
Cela conduit à deux menus légèrement différents qui vous sont présentés ci-après :  
 
 

11.3.1  Créer une nouvelle image 
Fichier -> Nouveau 
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Ici, nous choisirons la taille de notre image en 
pixels (ou autres unités …), et dans le menu options 
avancées :  
- la résolution de l’image en pixels/in (ou autres 

unités …), 
- si notre image est en niveaux de gris ou en 

RVB (rouge, vert, bleu), 
- et nous déciderons également si nous voulons 

un fond opaque ou transparent9. Comme nous 
pouvons le voir,  

 
Une fois les choix effectués, on obtient une 
nouvelle image en cliquant sur le bouton 
« Valider ». 

 

 
Unités de taille d’image : 
Plusieurs unités sont disponibles pour spécifier la taille des images. Voici quelques définitions utiles pour 
s’y retrouver : 
• Inch (In) : 1 pouce = 2,4 cm 
• Pixel (px) : plus petite unité distincte d’une image « bitmap » visualisée à l’écran. 
• Point (pt) : unité standard correspondant à environ 0,01383in (ce qui fait 72,27 pt par in) 
• Pica (pc) : unité industrielle d’impression correspondant à environ 0,166in (ce qui fait 6,0225 pc par in). 

Il y a 12 pts dans 1 pc. 
 
Résolution d’une image : 
 
Cette mesure exprime la qualité des sorties d’images (impressions, visualisation sur écran … par exemple). 
Elle est exprimée en dpi (Dots per inch) par exemple.  
Plus le nombre de « dots » est grand, plus l »’image sera lisse et d’apparence nette. Le plus couramment les 
imprimantes laser sont réglables en 300 ou 1200 dpi.  
 
dot matrix printer : imprimante pour laquelle chaque caractère est formé par une matrice de points (ou 
« dots ») 

11.3.2  Ouvrir une image 
Dans le menu Fichier, cliquez sur la commande Ouvrir…  
 
Une boîte de dialogue apparaît qui nous permet de naviguer dans nos répertoires (liste de gauche) et .. 
sélectionner l'image que nous voulons ouvrir (liste de droite). Dans le menu « Déterminer le type de 
fichier », nous pouvons choisir quel format de fichier nous voulons ouvrir, ou laisser GIMP le choisir 
automatiquement 

11.3.3  Enregistrer une image 
Gimp nous permet de sauvegarder nos propres images sous une variété de formats. 
A partir de la fenêtre contenant l’image à enregistrer (fenêtre active) :  
- activer la flèche en haut à gauche de la fenêtre  
- menu Fichier Æ commande Enregistrer sous … 
 
Une boîte de dialogue apparaît, et vous permet : 
- de naviguer dans vos répertoires (liste de gauche) afin de sélectionner le répertoire de destination, 
- de spécifier le nom de votre fichier image dans le champ "Sélection" 
de spécifier le type de ce fichier avec le menu : "Déterminer le type du fichier". 
 
                                                      
9 Il existe deux type de remplissage opaques de fonds: « Fond » (ou « Background ») et « Blanc » (ou « White »). 
« Blanc » permet d'obtenir un fond blanc et opaque, tandis que l'option « Fond » permet d’obtenir un fond ayant la 
couleur sélectionnée dans l'icône de couleur de la boîte à outils. Avec l'option « Transparent », le fond apparaîtra en un 
damier de blanc et de gris qui symbolise la transparence. C'est d'une grande utilité pour créer des images GIF 
transparentes. 
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Enregistrer dans le format png 
Attention : Le format png ne conserve pas les calques. Si votre image en comporte, il faudra fusionner les 
calques (exporter le format) de votre image avant de la sauvegarder (cf 9.7.4). 
 
Lorsque le choix png a été effectué, une boîte de dialogue apparaît, dans laquelle on peut modifier (entre 
autres) le niveau de compression de l'image selon une échelle de 1 à 6. 
Enregistrer dans le format jpg 
Attention : Le format jpeg ne conserve pas les calques. Si votre image en comporte, il faudra fusionner les 
calques (exporter le format) de votre image avant de la sauvegarder (cf 9.7.4).  
Lorsque le choix jpeg a été effectué, une boîte de dialogue apparaît, dans laquelle on peut modifier (entre 
autres) le taux de compression de l'image : une qualité élevée correspond à une faible compression, et 
inversement une qualité faible correspond à une compression élevée. 

11.3.4  Fermer une image sans quitter GIMP 
Menu Fichier Æ commande « Fermer » dans le menu flottant 
accessible par clic droit de la souris sur l'image, ou par la flèche 
en haut à gauche de l'image.  
Cette option fermera notre image, tandis que « Quitter » 
fermerait l'image et quitterait GIMP.  

 
 

 

11.4 Outils de sélection 
Les six premiers outils de la boîte à outil sont les outils de sélection : 
 

 

sélections rectangulaires ou elliptiques partant du coin où nous pressons le bouton de la 
souris. On peut utiliser les touches CTRL et/ou MAJ pour tracer à partir du centre et/ou 
tracer des carrés ou des cercles. 

 
Sélection libre pour dessiner une forme libre.  

 
La baguette magique travaille en sélectionnant les pixels adjacents de couleurs similaires. 
Elle commence à sélectionner là où nous cliquons et étend la sélection vers l’extérieur 
jusqu’à ce qu’elle considère que les couleurs sont trop différentes.  

 
Utiliser l'outil de sélection de Bezier en déposant des points d'ancrage suivant 
approximativement la forme finale désirée. Fermer la forme en plaçant le dernier point sur le 
premier. 
Dans un second temps on va ajuster la forme à l’objet à sélectionner : 
position des ancres : pour ajuster la position d’une ancre la sélectionner en cliquant sur la 
touche CTRL. 
Lissage de la forme : pour lisser une forme cliquer sur une ancre, cela fait apparaître deux 
poignets qui vont permettre de lisser la forme. En appuyant sur la touche MAJ, chaque 
poignet peut être manipulée séparément. 

 
Utiliser les ciseaux intelligents pour sélectionner des objets. 

 
 
Chaque outil de sélection est paramétrable. Pour accéder au réglage des 
paramètres à un outil, double-cliquer sur l’outil correspondant.  
 
Exemple des paramètres rattachés à l’outil de sélection rectangulaire : 
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11.5 Outils de dessin 

11.5.1  Outils de la fenêtre principale de GIMP 

 

Les outils disponibles permettent de : 

 récupérer des couleurs dans l’image, 

 remplir avec une couleur ou un motif, 

 remplir avec un dégradé de couleur, 

 tracer des traits de crayon précis, 

 peindre au pinceau d’un façon un peu floue, 

 gommer, 

 tracer à l’aérographe à pression variable, 

 peindre avec des motifs ou des portions d’images, 

 rendre flou ou faire ressortir les couleurs, 

 dessiner à l’encre (voir paramètres de réglage ci-contre). 

Chaque outil peut être 
réglable selon divers 
paramètres accessibles 
par un double-clic sur 
l’outil. 

 

 

Les paramètres de couleur, de motif, de forme de pinceau actifs à un instant 
donné sont ceux qui figurent dans les icônes du bas de la fenêtre principale de 
GIMP (voir § ci-dessous). 

 

11.5.2  Sélection du pinceau 

 
 

 

menu Fichier Æ commande Dialogues Æ 
Pinceaux … 
la fenêtre de gauche : « Sélection du pinceau » 
est alors accessible. On y trouve toutes les 
brosses qui peuvent être utilisées dans une 
session GIMP. Utilisez l’ascenseur de droite de la 
fenêtre pour faire défiler l’ensemble des motifs 
disponibles. 
 
Cliquez sur le motif correspondant pour 
sélectionner une brosse : 
- un encadré noir délimite alors l’objet 

sélectionné, 
- son nom et sa taille en pixels apparaissent 

juste au-dessous de la barre de titre de la 
fenêtre « sélection du pinceau », 

- l’espacement qui vous donne la distance 
entre vos empreintes de brosse. Une distance 
de 0 marquera un trait continu, 

- le motif retenu apparaît en bas à droite de la 
fenêtre principale de GIMP. 

Pour créer vos propres motifs, cliquez sur le 
bouton nouveau. La fenêtre de droite apparaît, et 
vous permet de personnaliser vos motifs.  
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11.6 Manipulation des couleurs 

11.6.1  Les couleurs des plans dans l’image 
En bas à gauche de la fenêtre  
principale de GIMP : 

 
 

Couleurs de premier (AV) et d’arrière (AR) plans : 
- Couleur AV : rectangle haut, 
- Couleur AR : rectangle bas, 
- Par défaut les couleurs AV et AR sont respectivement 

en noir et blanc, 
La couleur du pinceau prendra la couleur de l’AV 

 
 

Pour inverser les couleurs des plans AV et AR cliquez 
sur la double flèche : 

 

 

 
 

 

Pour remplir des plans d’images avec les couleurs de AV 
et AR, cliquez sur la flèche de la fenêtre image concernée, 
puis aller dans le menu édition et sélectionner « Remplir 
avec ….. ». 

 

11.6.2 Modification des couleurs des plans de l’image 
Modification des couleurs de plans : 
Pour modifier les couleurs d’un plan d’image, faire un double clic sur l’icône concerné (AV ou AR). Une 
boîte de dialogue à 4 onglets apparaît. Chaque onglet vous donne accès à un outil vous permettant de choisir 
votre nouvelle couleur. Nous ne vous présentons ci-dessous que deux de ces outils : GTK et GIMP. 
 
Modèles de couleur : 
La manipulation des couleurs de l’image est basée sur les modèles de couleur RVB/RGB (Rouge/Red, 
Vert/Green, Bleu/Blue) et TLS/HLS (Teinte/Hue, Luminance, Saturation) utilisés pour classifier et 
normaliser les couleurs. 
Le modèle RVB/RGB : 
Ce système est appelé mode colorimétrique additif. Chaque couleur dans le mode RVB a une valeur en 
rouge, en vert et en bleu. Ces valeurs vont de 0 à 255, où 0 dans les trois couleurs simultanément équivaut à 
noir et 255 pour les trois couleur simultanément équivaut à blanc. Ceci signifie que vous pouvez ainsi 
obtenir plus de 16 millions de couleurs (TrueColor) car 256x256x256= 16 777 216 mais uniquement 256 
tons de gris si vous avez une sortie moniteur de 8 bits. 
Le modèle TLS/HLS : peut être aussi appelé modèle HSV (Hue, Saturation, Value) 
La teinte indique où la couleur se trouve sur le spectre du visible, c’est-à-dire de quel couleur de l’arc en ciel 
il s’agit : rouge, orange, indigo, vert ou jaune. Comme sur l’arc en ciel, la couleur de début et de fin est le 
rouge. La teinte peut être ébauchée comme un cercle coloré avec le rouge à 0 degrés, le jaune à 60 degré; 
dans le sens inverse des aiguilles d’une montre, et ainsi de suite avec le vert, cyan, bleu, magenta et rouge à 
nouveau à 360 degré; 
La saturation donne la valeur de pureté de la couleur. (comme le réglage de la couleur sur un poste de télé) . 
Les valeurs de saturation vont de 0 (noir et blanc ou niveaux de gris) à 100 (couleurs saturées), ou une valeur 
basse montre un couleur neutre et terne et une grande valeur, une couleur pure et prononcée.  
La luminance a rapport avec l’intensité lumineuse. Zéro signifie le noir total et 100 est l’intensité maximum 
qu’une couleur peut avoir. Une valeur de 100 en intensité ne signifie pas forcement blanc (sauf si la 
saturation est à zéro), c’est juste la plus forte intensité d’une couleur ayant une certaine saturation. 
 
Les outils GTK et GIMP : 
Les outils mis à votre disposition pour faire vos choix de couleur utilisent donc les deux modèles 
précédemment introduits. Pour chacun des deux outils vous avez deux possibilités de régler vos couleurs : 
- par réglages des valeurs numériques dans les canaux RVB ou TLS à l’aide des curseurs appropriées, 
- par déplacement de curseurs sur représentation graphique des couleurs. 
Les deux modes sont dynamiquement corrélés. 
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Représentations graphiques : 
Outil GTK : 
Le cercle des coloration reproduit le paramètre circulaire de teinte (cf § ci-dessus). Le paramètre de 
saturation est porté sur l’axe du rayon du cercle : plus vous allez au bord du cercle plus la saturation est 
élevée. La pompe à droite du cercle permet de régler la luminance. 
Outil GIMP : 
Le carré de couleur apparaît monochrome avec des dégradés d’intensité. Sa teinte est déterminée par le choix 
porté sur l’échelle des teintes située sur la droite du carré de couleur (échelle arc-en-ciel). Les dégradés 
d’intensité sont à attribuer à la saturation pour l’axe des ordonnées et à la luminance sur l’axe des abscisses. 
Le code hexadécimal de la couleur vous est donné en bas et à droite de l’onglet correspondant. 
 
Ré-initialisation des couleurs Noir & Blanc : 
Il est possible à tout moment de retourner au mode NB (Noir & Blanc) an cliquant sur le petit icône en bas à 
gauche de la fenêtre principale du logiciel conformément au schéma ci-dessous : 

        
 

11.6.3  Couleur de pinceau 
La couleur du pinceau est celle qui a été affectée au plan AV. 
 

11.7 Les calques 

11.7.1 La notion de calques 
Pour faciliter la construction des images, 
GIMP permet de travailler en multi-
couches (ou calques). 
 
Le schéma ci-contre vous explique le 
principe de cette conception muti-
couches. 

 
Représentation d’une image 
selon ses différents calques 

 
 
 

 
 

Représentation finale de image 
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11.7.2 L’utilisation de calques 

 
(1) 

depuis la fenêtre image 

Passer par la boîte de dialogue « Calques, canaux et 
chemins » accessible par : 
 
 
(1) depuis la fenêtre image : 

 Æ menu Calques Æ 
« Calques, canaux et chemins »  
 
 
(2) depuis la fenêtre principale : 
menu Fichier  Æ Dialogues. Æ 
« Calques, canaux et chemins »  
 

 
 

 

 
(2) 

depuis la fenêtre 
principale 

 

 

Dans la zone Image : 
apparaît le nom du fichier image en traitement. 
(exemple : Test.tiff) 
 
L’onglet Calques permet d’accéder à la liste des calques : 
(exemple : un seul calque « Fond ») 
 

 pour visualiser un calque 
 

 pour créer un nouveau calque 
 

 pour dupliquer un calque 
 

 pour supprimer un calque. 
 

11.7.3 La visualisation de calques 
Dans cet exemple, il y a un fond comportant des gribouillis noirs et un remplissage blanc, et un calque 
comportant un gribouillis rose et un remplissage transparent. 
 

 
 

 

 
Dans cette situation, les 2 sont 
superposés et visibles dans l'image 
(à gauche), car les 2 sont activés 

comme en atteste le symbole  
de la boite de dialogue "Calques, 
canaux & chemins". 
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Dans cette situation, seul le fond 
est visible, car lui seul est activé :  

le symbole  figure en regard 
du fond mais pas du calque 
nommé "Nouveau calque". 

 
 

 
Dans cette situation, seul le calque 
nommé "Nouveau calque" est 
visible, car lui seul est activé :  

le symbole  figure en regard 
du calque mais pas du fond.  
 
Le quadrillage gris indique qu'il y 
a un remplissage transparent (cad 
pas de couleur de remplissage) 

 

11.7.4  Enregistrer des images avec calques  
Il faut enregistrer l’image au format GIMP (.xcf), qui est le seul à conserver la notion de calques. 
Si vous souhaitez enregistrer une image avec des calques dans un autre format, il faudra "fusionner les 
calques" avant l'enregistrement. Les calques seront alors perdus, il ne restera que l'image finale. 
Pour fusionner les calques avant la sauvegarde, faire : Calques -> Fusionner les calques 
 
Si la fusion des calques n'a pas été faite avant l'enregistrement, une boîte de dialogues apparaîtra alors. 
Cliquer sur "Exporter". Le résultat sera également de fusionner les calques. 

11.8 Introduire du texte 

11.8.1  Méthode directe 

Dans le tableau d’outils de la fenêtre principale, activer l’outil texte  qui permet d’intégrer du texte. 
Cliquer dans l’image à l’endroit où vous voulez placer le texte, une boîte de dialogue apparaît : 
Faites vos choix de fonte (style, taille) et écrivez votre texte dans la zone Aperçu (exemple : toto) Æ Ok.  
 
Le texte apparaît en scintillant :  
Il peut alors être déplacé à la souris. Pour désactiver l'outil texte, cliquer sur n'importe quel autre outil de la 
fenêtre principale. Le texte est alors intégré à l'image et ne peut plus être modifié : 

11.8.2  Méthode avec calques 
Nous choisirons toujours d’introduire du texte en créant de nouveaux calques, ce sera une sécurité afin de 
pouvoir porter des corrections plus facilement et ainsi perdre moins de temps. 
Nous suivrons donc les étapes suivantes : 
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Etape 1 
Dans le tableau d’outils de la fenêtre principale, activer l’outil 

texte qui permet d’intégrer du texte. 
 
Etape 2 
Cliquer dans l’image à l’endroit où vous voulez placer le texte, la 
boîte de dialogue suivante apparaît : 
Faites vos choix de fonte (style, taille) et écrivez votre texte dans 
la zone Aperçu (exemple : Bonjour) Æ Ok. 

Etape 3 
Depuis la fenêtre image, faîtes apparaître la boîte de dialogue des 
calques :  

 Æ menu Calques ÆCalques, canaux & chemins  
La liste des calques laisse apparaître un nouveau calque nommé 
« Sélection flottante ». 
Double-cliquer sur le terme « sélection flottante » et donner un 
nom à ce nouveau calque. 
(Exemple : Bonjour) 

Etape 4 
En utilisant le mode de visualisation des calques nous pouvons 
vérifier que le texte est bien dans un calque qui lui est propre. 
Remarquons que nous en avons profité pour renommer le « nouveau 
calque » en « Trait ». 

 

 
 
Avec plusieurs textes sur des calques différents, cela peut donner : 
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11.9 Images à zones cliquables multiples (MAP) 
Une image à zones sensible est une images possédant plusieurs zones cliquables distinctes. Cela est obtenu 
par un code html particulier associé à une image : 
Syntaxe html : 

<MAP NAME="sectionmap"> 
<AREA SHAPE="forme" COORDS="x1,x2,X3,X4" HREF="adresse_cible1"> 
<AREA SHAPE="forme" COORDS="y1,y2,y3,y4" HREF="adresse_cible2"> 
….. 
</MAP> 
<IMG SRC="adresse_image" USEMAP="#sectionmap"> 

où “forme” est la forme (rect, poly, …) de la zone cliquable, x1,x2,X3,X4 les coordonnées en pixels 
de cette forme.  
GIMP génère automatiquement ce code html. 
 
Démarche à suivre : 
1 - Ouvrir l’image désirée. 
2 - Si ce n'est pas déjà le cas, réparer l’image dans un format .png, jpg, ou gif 
Si votre images présente plusieurs calques il va falloir les fusionner dans une même image (voir aussi § 
9.7.4) : 

 Æ menu Calques Æ « Fusionner les calques visibles …»  
Puis enregistrer votre image au format .png (ou jpg ou gif), formats compatibles avec la diffusion sur le Web 
(cf 9.3.3). 
3 - Définir les zones « cliquables »  
Dans la fenêtre de notre image au 
format .png : 

 Æ menu Filtres Æ Web Æ 
« Image cliquable Web…»  
Une nouvelle fenêtre apparaît 
« ImageMap » qui reprend l’image 
sélectionnée. 
Cette fenêtre permet de définir des 
zones de forme rectangulaires, ovales 
ou polygonales.  
 

Par exemple, on peut définir une zone rectangulaire entourant le texte « Bonjour » : 
- cliquer sur le bouton "rectangle" dans la palette d'outil verticale à gauche de l'image. 
- avec la souris, définir la zone rectangulaire autour du texte "bonjour" 
- Dans la boîte de dialogue qui apparaît, indiquer alors l’URL voulue, puis valider.  
 
On peut faire cela sur plusieurs parties de l’image, répéter alors les opérations ci-dessus autant de fois que 
souhaité. 
 
Pour faire une zone de forme polygonale, cliquer sur le bouton "polygone" à gauche de l'image, et cliquer 
sur tous les angles du polygone souhaité. Il est recommandé d'utiliser la loupe. 
 
4 - Enregistrer au format html en utilisant le menu Fichier de cette fenêtre, avec une extension html . 
Une "carte" des zones cliquables est alors définie. Le contenu de ce fichier peut ensuite être intégré dans une 
page Web, à l'aide d'un éditeur de page web (par exemple, WebExpert). 
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12  WinSCP  
 
"WinSCP" est un logiciel permettant de transférer des fichiers entre 2 ordinateurs reliés par réseau. Il permet 
par exemple de copier le site Web que l'on a développé sur son ordinateur perso vers un serveur HTTP 
(ordinateur équipé d'un logiciel permettant la diffusion sur Internet des pages Web).  
 
Avant de tenter un transfert de fichiers, il faut bien évidemment avoir un compte (login, mot de passe) sur un 
serveur. Dans les manipulations décrites ci-dessous, nous supposerons que l'on a un compte (login toto, mot 
de passe xxx) sur le serveur ufrima.imag.fr, mais la démarche peut être faite avec n'importe quel autre 
serveur en réseau. 
 
Pour lancer ce logiciel, allez dans le menu Démarrer – 
Tous les programmes – WinSCP3. 
Sélectionner WinSCP. 
 
 
Une fenêtre "Session" s'ouvre. (Figure ci-contre) 
Dans le champs "Nom d’hôte", inscrivez : 
ufrima.imag.fr 
Dans les champs "Nom d’utilisateur" et "mot de passe", 
inscrivez votre login et mot de passe 
Cliquez sur OK. 

 
Une boîte de dialogue peut s’ouvrir pour signaler que vous devez acceptez une clef. Acceptez si vous faîtes 
confiance au serveur sur lequel vous vous connectez.  
Une fenêtre s'ouvre. Elle comporte 2 parties principales : 

 
A droite, vous voyez les fichiers du serveur distant. A gauche de la fenêtre, vous voyez vos fichiers sur votre 
PC habituel (machine locale ou Local System).  
 
Pour transférer un fichier d’une machine vers une autre, sélectionnez le fichier, puis faîtes glisser l’icône sur 
l’autre partie. Il faut répondre « copier » à la question posée. 
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13  Guide des commandes algorithmiques et VBA 
 

13.1 Boîte à outils (création d’objets) 
Instruction algorithmique 
Instruction Visual Basic Application 

Commande 
PowerPoint  

Rectangle (X , Y , L, H)   
X, Y : coordonnées du coin supérieur gauche, L : largeur, H : hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeRectangle
, X , Y , L, H).Select 

 

Carré (X , Y , C) X, Y : coordonnées du coin supérieur gauche, C : coté 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeRectangle
, X , Y , C, C).Select 

MAJ    

Ellipse (X , Y , L, H)    
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeOval, X , Y , L, H).Select 

 

Cercle (X , Y , D)   
X, Y : coordonnées du coin supérieur gauche du carré encadrant, D : diamètre 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeOval, X , 
Y , D, D).Select 

MAJ    

Trait (X1, Y1, X2, Y2)  X1, Y1 : coordonnées de la première extrémité, X1, Y1 : 
coordonnées de la deuxième extrémité 
ActiveWindow.Selection.SlideRange.Shapes.AddLine(X1, Y1, X2, Y2).Select  

Triangle (X , Y , L, H)    
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeIsoscelesTriangle, X , Y , L, 
H).Select 

Formes auto 
→ formes de 

base →   

Losange (X , Y , L, H)    
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeDiamond, 
X , Y , L, H).Select 

Formes auto 
→ formes de 

base →   

Hexagone (X , Y , L, H)    
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeHexagon, 
X , Y , L, H ).Select 

Formes auto 
→ formes de 

base →   

Sablier (X , Y , L, H)    
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeFlowchart
Collate, X , Y , L, H ).Select 

Formes auto 
→ 
organigramme 

→   
Bitriangle (X , Y , L, H)    
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeFlowchart
Sort, X , Y , L, H ).Select 

Formes auto 
→ 
organigramme 

→   
Pentagone régulier(X , Y , L, H)   
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeRegularPe
ntagon,X ,Y  ,L ,H ).Select 

Formes auto 
→ formes de 

base →   

Pentagone (X , Y , L, H)   
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapePentagon, 
X , Y , L, H ).Select 

forme 
automatique 
→ flèches 
pleines  

Chevron (X , Y , L, H)   forme 
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X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeChevron,X
,Y,L,H).Select 

automatique 
→ flèches 
pleines  

Arche (X , Y , L, H)   
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeFlowchart
Delay,X,Y,L,H).Select 

forme 
automatique 
→ 
organigramme
s 

 
Lune (X , Y , L, H)   
X, Y : coordonnées du coin supérieur gauche du rectangle encadrant, L : largeur, H : 
hauteur 
ActiveWindow.Selection.SlideRange.Shapes.AddShape(msoShapeMoon, X, 
Y, L, H).Select 

forme 
automatique 
→ formes de 
base  

Les coordonnées sont en pixels, dans le repère de la feuille ppt. 
 

13.2 Actions modifiant un objet     
(Toutes ces actions s’appliquent à un objet défini dans l’instruction précédente) 
Instruction algorithmique 
Instruction Visual Basic Application  

Commande PowerPoint 

Couleur (cc)     cc : nom de la couleur (rouge, bleu, jaune, …) 
With ActiveWindow.Selection.ShapeRange 
        .Fill.Visible = msoTrue 
        .Fill.Solid 
        .Fill.ForeColor.RGB = RGB(H1,H2,H3)  
End With 
(H1,H2,H3) : codage VBA des couleurs.  
Par exemple : (255, 0, 0) = rouge,  (0, 0, 255) = bleu,  (255, 255, 0) = jaune 

Double clic sur objet → 
onglet couleurs et traits : 
couleur 

Translucide 
ActiveWindow.Selection.ShapeRange.Fill.Visible = msoFalse 

Double clic sur objet → 
onglet couleurs et traits : 
translucide 

Rotation (A)  
A est l'angle de rotation, positif dans le sens des aiguilles d'une montre 
ActiveWindow.Selection.ShapeRange.Rotation = A 

Double clic sur objet → 
onglet taille : rotation= 

Retourner_horizontalement   
retournement par rapport à un axe vertical  
ActiveWindow.Selection.ShapeRange.Flip msoFlipHorizontal 

Dessin → Rotation ou 
retournement  → retourne-

ment horizontal →  
Retourner_verticalement    
retournement par rapport à un axe horizontal  
ActiveWindow.Selection.ShapeRange.Flip msoFlipVertical 

Dessin → Rotation ou 
retournement  → retourne-

ment vertical →   

13.3 instructions générales de base : 
Algorithmique Programmation VBA 
Définir un algorithme : 
Algo Toto 
Début 
….. 
Fin 

Sub Toto 
… 
End Sub 

Déclaration de variable : réservation d’un espace mémoire auquel on donne 
un nom et dont on définit le type.          
  t : entier        R : réel      ch : chaîne de caractères 

Dim t As Integer  
Dim R As Real 
Dim ch As String 

Affectation : mettre une valeur dans une variable 
  T ← 0      R ← 3.1    Ch ← « bonjour » 

T=0 
R=3.1 
Ch= "bonjour" 

Itération (ou boucle)  « Tant Que » : Répétition d’un traitement, l’arrêt de Do While t <100 
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la boucle étant déterminé à partir de la réalisation d’une condition :  
 Tant Que (condition) faire    ……….    Fin Tant Que 

… 
Loop 

Itération (ou boucle)  « Pour » : Répétition d’un traitement, l’arrêt de la 
boucle étant déterminé à partir d’un certain nombre de réalisations connu par 
avance.   Pour t=1 jusqu’à 100 faire ……….  Fin Pour 

For t =1 to 100 
… 
Next 
If a=b Then 
… 
End If 

Condition :  
Si (condition) alors (instructions) 
 
Si (condition) alors (instructions) sinon (instructions) 
 If a=b Then 

… 
Else 
… 
End If 

Définir un algorithme  avec paramètres (exemple toto) : 
Algo Toto (X, Y : entiers) 
{les variables données en exemple : X, Y sont passées en paramètre de la 
procédure} 
Début 
….. 
Fin 

Sub Toto (X, Y As Integer) 
… 
End Sub 

Utiliser un algorithme (ici, exemple toto vu précédemment) avec 
paramètres : 
Toto (X, Y) 

Call toto(X, Y) 

 

13.4 Fonction utile : 
Algorithmique Programmation VBA 
Génération d’un nombre aléatoire compris entre 0 et 1 : 
Rnd ()                   {renvoie un réel compris entre 0 et 1} 

Rnd() 

 

13.5 Instructions propres à PowerPoint: 
Instruction algorithmique 
Instruction Visual Basic Application  
Nommer (« carrebleu ») 
ActiveWindow.Selection.ShapeRange.Name = "carrebleu" 
Ou : 
With ActiveWindow.Selection.ShapeRange 
     .Name = "carrebleu"     ‘ attention, il faut mettre le point devant Name 
End With 
Selectionner (« carrebleu », « rondrouge ») 
ActiveWindow.Selection.SlideRange.Shapes.Range(Array("carrebleu", "rondrouge")).Select 
Grouper   Cette instruction doit obligatoirement suivre l’instruction « sélectionner » 
ActiveWindow.Selection.ShapeRange.Group.Select 
Copier   Copie un objet préalablement sélectionné 
ActiveWindow.Selection.Copy 
Coller   colle un objet préalablement copié ou coupé 
Pour fonctionner de façon contrôlée cette action doit être suivie des actions permettant de positionner 
l’objet dans le repère orthonormé de l’écran : 
ActiveWindow.View.Paste 
With ActiveWindow.Selection.ShapeRange 
            .Left = X     ‘ attention, il faut mettre le point devant Left et Top 
            .Top = Y 
End With 
Désélectionner   désélectionne un objet préalablement sélectionné 
ActiveWindow.Selection.Unselect 
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14  Lexique HTML 
 

 
Ce lexique n’est pas un inventaire exhaustif des balises existantes, c’est simplement une 
référence pour le travail qui sera abordé dans cet enseignement. Pour ceux qui désirent aller 
plus loin, des guides beaucoup plus complets existent sur le web.  
 

14.1 Le langage HTML  
L'idée générale de HTML est de saisir le texte sans mise en forme et d'insérer dans les endroits convenables 
les consignes de présentation souhaitées. HTML n'est donc pas à proprement parler un langage de 
programmation mais un langage de balisage.  
 
Pour distinguer ces commandes de présentation du texte normal on leur impose de respecter une règle: être 
encadrées par les deux symboles < et >. Ces commandes de présentation s'appellent des « balises » (ou 
« marqueurs » ou « tags » in english). Le langage HTML est donc uniquement composé de marqueurs, 
délimités par les caractères "<" et ">", et dont le contenu est une commande HTML suivie d'éventuels 
paramètres : 
<UneCommande> Avec ici un texte </UneCommande> 
<UneCommande DesParamètres> Avec ici un texte </UneCommande> 
Tout ce qui n'est pas compris entre "<" et ">" est tout simplement considéré comme du texte à afficher. Un 
marqueur HTML et ses paramètres peuvent être indifféremment écrit en majuscules ou en minuscules.  
 
Les marqueurs vont en général par paire, comme des parenthèses que l’on ouvre, puis que l’on referme un 
peu plus loin, et délimitent ainsi le texte qui doit être affecté par la commande. Si la balise « ouvrante » est 
de la forme : <XXX>, la balise « fermante » sera de la forme : </XXX> 
exemple :  

 <I> Avec ici un texte </I>  
indique que le texte saisi (Avec ici un texte) devra apparaître en italiques. Le navigateur qui interprétera la 
page html (client), à condition qu'il dispose d'une police convenable, devrait fournir un affichage du type:  

Avec ici un texte 
 
Si plusieurs balises sont affectées au même texte, c'est au concepteur de pages HTML d'imbriquer 
correctement ces marqueurs. La vérification par le client n'est pas assurée. La règle est : première balise 
ouverte, dernière fermée. 
Exemple correct : 

<b> <I> mon texte </I> </b> 
fournira l’affichage en gras et en italique : 
 mon texte 

Exemple incorrect : 
<b> <I> mon texte </b> </I> 

le client ne tiendra pas compte des balises. 

 

14.2 Les balises indispensables : 
Un document HTML "standard" (une page web) doit obligatoirement comporter les éléments suivants, 
même s’ils sont vides :  
<HTML> … </HTML>  début et fin de la page web  
<HEAD> …  </HEAD>   en-tête  
<TITLE> … </TITLE>  titre : ce qui apparaît dans la barre de titre. 
<BODY> … </BODY> corps du document, contenant le texte et les différents éléments à afficher 
dans la page web. 
Ces éléments doivent être imbriqués de la manière suivante : 

<HTML> 
  <HEAD> 
     <TITLE> </TITLE> 
  </HEAD> 
  <BODY> 
  … 
  </BODY> 
</HTML>  
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Exemple : 

<HTML> 
  <HEAD> 
     <TITLE>La page à toto</TITLE> 
  </HEAD> 
  <BODY> 
  Bienvenue dans la page a toto. 
  </BODY> 
</HTML>  

 

 
 

14.3 Les balises du corps du document : 
Ce sont les balises que l’on placera à l’intérieur de <BODY> … </BODY>, et qui affecteront directement 
l’apparence de chaque page web. 
 

14.3.1  Formatage du texte 
marqueurs physiques : balises spécifiant l’apparence que doit prendre le texte. 
 
<B> … </B> : texte en gras  
<STRONG> … </STRONG> : texte en gras également  
<I> … </I> : texte en italique 
<U> … </U> : soulignés (underline) 
<S> … </S> : caractères barrés (strike) 
<SUB> … </SUB> : indices (subscript) 
<SUP> … </SUP> : exposants (superscript) 
<BIG> … </BIG> : caractères de grande taille  
<SMALL> … </SMALL> : caractères de petite taille  
<TT> … </TT> : police non proportionnelle, dite à chasse fixe (teletype) 
<PRE> … </PRE>  : maintient une mise en forme préétablie  
                d'un texte (police à chasse fixe,  
                respect des espaces, tabulations et  
                retours-chariots),  
                par exemple  
                pour présenter un programme informatique. 
 
Paragraphe : <P> … </P>        insère automatiquement une ligne blanche  
Retour à la ligne (break row) :  <BR>  
Trait horizontal occupant la largeur de la fenêtre (horizontal row) :  <HR>  
<P>, <BR> et <HR> n'ont pas besoin d'être fermées. 
 
marqueurs sémantiques (ou logiques) :  
Balises renseignant sur la nature du texte à mettre en forme. Combinées avec des feuilles de style, elles 
permettent de donner un aspect différent à certains éléments particuliers du texte. 
 
<EM> … </EM>: emphasis. (italique) 
<ADDRESS> … </ADDRESS> : addresse (italique) 
<CITE> … </CITE> : citation (italique)   
<DFN> … </DFN> définition 
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<BLOCKQUOTE> … </BLOCKQUOTE> : présente un paragraphe telle une citation en alinéa (retrait) 
comme dans l'exemple ci-dessous: 
       Ce texte a été analysé par plusieurs auteurs dont Messieurs DeLaRoche, 
       Dupuis et Dumont. Ils en sont tous venus à la conclusion que le grand mérite 
       réside dans la traduction parfaite d'un texte déjà publié par un australien du 
       nom de McIntyre. 
 
Niveaux de titre et sous-titres (Headers) : 

<H1> … </H1> :  Exemple de header de niveau 1 

<H2> … </H2> :  Exemple de header de niveau 2 
<H3> … </H3> :  Exemple de header de niveau 3 
<H4> … </H4> :  Exemple de header de niveau 4 
<H5> … </H5> :  Exemple de header de niveau 5 
<H6> … </H6> :  Exemple de header de niveau 6 
Il n'y a pas de niveau inférieur à H6  
 

14.3.2  Les accents et les signes diacritiques  
Le langage html, d’origine américaine, a été initialement conçu sans caractères accentués ou spéciaux. 
Certains navigateurs français récents peuvent les reconnaître. Pour qu’une page web soit correctement 
interprétée par tous les navigateurs (anciens ou étrangers) il faut coder ces caractères de manière suivante : 

• &acirc;  â  
• &eacute;  é  
• &amp;  &  (ampersand) "et" commercial  
• &gt;  >  (greater than)  
• &lt;  <  (less than)  
• &quot;  "  (quotation) double guillemet  
• &nbsp;   (non-breaking space) espace insécable 

 
Règle de construction des caractères accentués :  
(&)+ lettre accentuée (a,e,i,o,u) + type d'accent (circ,acute,grave) + ( ; ) 
 

14.3.3 Listes  
Listes non ordonnées <UL>  (listes sans numérotation) 
 

• premier point  
• deuxième point  

• premier point secondaire  
• deuxième point secondaire 

<UL> 
<LI>premier point 
<LI>deuxième point 
<UL> 
<LI>premier point secondaire 
<LI>deuxième point secondaire  
</UL> 
</UL> 

 
Listes ordonnées <OL>  (listes avec numérotation) 
La numérotation est automatiquement réalisée par le client. 
 

1. premier point  
2. deuxième point  

• premier point secondaire  
• deuxième point secondaire 

<OL> 
<LI>premier point 
<LI>deuxième point 
<UL> 
<LI>premier point secondaire 
<LI>deuxième point secondaire  
</OL> 
</OL> 

 

14.3.4 Attributs (ou paramètre) d'une balise 
Syntaxe :  <Commande Paramètre1=valeur1 Paramètre2=valeur2 > texte </Commande> 
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Exemples : 
<H1 align = center> Ce titre est au centre </H1> 

 

Ce titre est au centre 
 
<H2 align = left> Cette ligne est justifiée à gauche </H2> 
 
Ce sous-titre est aligné à gauche 
 
<P align = right> Ce paragraphe justifié à  droite. Bla bla bla bla bla 
bla bla. Ce paragraphe justifié à  droite. Bla bla bla bla bla bla bla. 
Ce paragraphe justifié à  droite. Bla bla bla bla bla bla bla. </P> 

 

Ce paragraphe est justifié à  droite. Bla bla bla bla bla bla bla. Ce 
paragraphe est justifié à  droite. Bla bla bla bla bla bla bla. Ce paragraphe 

est justifié à  droite. Bla bla bla bla bla bla bla. 

 
<BODY background="le_chemin_unix/mon_image.jpeg" > 
permettra d'utiliser comme fond d'écran un pavage constitué à partir de l'image indiquée. 
 

14.3.5 Les liens (ou pointeurs) :  <A> … </A> 
Les liens forment l’essence même du web : c’est ce qui permet de passer d’une page à l’autre en cliquant sur 
un texte ou une image . 
Syntaxe : 
<A HREF="adresse_cible"> texte du lien ou image cliquable </A>  
 
texte du lien ou image cliquable  
 
l'adresse cible peut être:  
 
• Un document distant : 
<a href="http://www.ujf-grenoble.fr"> 
<a href="http://www-valence.ujf-grenoble.fr/~girod/COURS_INTERNET"> 
<a href="http://www.grr.ulaval.ca/grrwww/manuel/manuelhtml.html"> 
 
• un document local (sur le même serveur)  
<a href="../répertoire/monFichier.html"> 
 
• Une ancre (ou cible, ou point d'accès) sur le même fichier :  
 <a href="#ancre"> 
Auparavant, cette ancre doit avoir été définie au moyen de :  
<A NAME="ancre"> texte de l'ancre <A> 
 
♦ Une ancre à l'intérieur d'un fichier local … 
<a href="../répertoire/monFichier.html#ancre"> 
              … ou distant : 
<a href="http://www-valence.ujf-grenoble.fr/~girod/COURS_INTERNET/chap4/Cours_html.html#Heading4"> 
 
♦ Une adresse électronique (protocole mailto) :  
<A href="mailto:toto@glaciog.ujf-grenoble.fr"> Envoyer un mail Toto </A>  
 
Envoyer un mail à Toto 
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14.3.6  Formulaires 
Un formulaire est une zone de la page web comportant : des zones de saisie de texte, des zones à choix 
multiples, des listes de choix, des cases à cocher, ou des boutons. 
Le formulaire est délimité par la balise <FORM>:  
<FORM ACTION="XXX" METHOD=YYY NAME=ZZZ> … </FORM>  
XXX : URL du programme chargé de récupérer et éventuellement de traiter les données. 
YYY : méthode de transmission des données (POST : par fichier ou GET : par l’URL) 
ZZZ : nom du formulaire 
 
Exemple 1 : 
<FORM METHOD=GET ACTION="/cgi-bin/cours1" NAME="q"> 
… 
</FORM>  
Exemple 2 : 
<FORM ACTION="mailto :toto@glaciog.ujf-grenoble.fr" METHOD=POST> 
… 
</FORM>  
 
• Boutons radios et cases à cocher 

     
 
<INPUT TYPE=… NAME=… VALUE=… CHECKED> … </INPUT> 
avec  TYPE = RADIO      pour les boutons multiples 
  TYPE = CHECKBOX   pour les cases à cocher 
 NAME = "un-nom"   qui identifie le bouton 
      VALUE= "valeur"   donnée au bouton lorsqu'il est sélectionné 
      CHECKED          signale un bouton (RADIO) ou une case cochée avant saisie (CHECKBOX) 
 
• Boutons cliquables 

 
 
<INPUT TYPE=… NAME=… VALUE=… ONCLICK=… CHECKED> … </INPUT> 
avec   TYPE = SUBMIT     pour envoyer les données du formulaire une fois rempli. 
  TYPE = RESET      pour effacer le contenu du formulaire. 
 TYPE = "button"      pour transmettre les données du formulaire à une fonction. 
      NAME = "un nom"   qui identifie le bouton. 
      VALUE= "nom"   texte affiché sur le bouton. 
 ONCLICK = "une-fonction" fonction à activer lorsque le bouton est cliqué. 
 
• Texte libre sur une ligne    

 
 
<INPUT TYPE=… NAME=… SIZE=…> … </INPUT> 
  avec  TYPE = TEXT       pour faire saisir du texte 

TYPE = PASSWORD   les caractères saisis sont représentés par des '*' 
TYPE = HIDDEN     le champ est caché : utile pour transmettre des informations non visibles. 
NAME = "un nom"  qui identifie le champ texte 
SIZE = nombre maximum de caractères visibles 

 
• Texte libre sur plusieurs lignes  

 
<TEXTAREA NAME=… ROWS=… COLS=…> … </TEXTAREA> 
  avec  NAME = "un nom"  qui identifie le champ texte 



UJF Licence Sciences – INF 112 Guide  

79 

        ROWS = nombre de lignes visibles 
        COLS = nombre de colonnes visibles 
 
• Menu    

 
<SELECT NAME=… VALUE=…>  
  <OPTION> texte de l’option  
  <OPTION SELECTED> texte de l’option 
</SELECT> 
  avec :  NAME = "un nom"  (non affiché) qui identifie le menu, 
 VALUE= "valeur"   valeur de chaque choix du menu.  

<OPTION> représente chaque choix du menu, SELECTED signalant le choix présenté par défaut. 
 

14.3.7  Les tables 
Balises HTML de base d'une table : 
<TABLE> … </TABLE> Création d'un tableau. 
<TR> … </TR>  Définition d'une rangée, à utiliser pour chacune des rangées requises,  
     à l'intérieur des deux balises <TABLE> … </TABLE>.  
<TD> … </TD>     Définition d'une cellule de la table, à insérer à l'intérieur des deux balises <TR> … 

</TR>. 
 
Attributs de la balise <table> 
BORDER: - permet d'afficher une ligne entourant chaque cellule du tableau 
   - définit un encadrement d'épaisseur variable autour du tableau 
CELLSPACING : détermine l'épaisseur de la bordure entre les cellules. 
CELLPADDING : détermine l'espacement entre le texte de chaque cellule et sa bordure. 
WIDTH : permet de spécifier la largeur totale d'un tableau  
- Soit en pourcentage de la largeur de la fenêtre. Ainsi, si vous redimensionnez cette fenêtre plus large ou 
plus étroite, le tableau se recalculera en conséquence. 
- Soit en nombre de pixels. La largeur du tableau est alors fixe. 
Remarque : cet attribut capricieux ne donne pas toujours le résultat prévu… 
BGCOLOR="#RRVVBB" : spécifie la couleur de fond des cellules de la table  
RR, GG et BB sont les valeurs hexadécimales des composantes Rouge(RR), Verte(VV) et Bleu(BB). 
Remarque : cet attribut s'applique s'applique aussi à <body>, <TR> et <TD> 
 
Exemple : 
<TABLE border=1 width=100% CELLSPACING=0 CELLPADDING=3 bgcolor="#CEF0F0"> 
 
Attributs des balises <TR> et <TD> 
ALIGN  permet d'aligner le contenu des cellules : 

à gauche ALIGN=LEFT  
à droite ALIGN=RIGHT ou au centre ALIGN=CENTER  

Par défaut : alignement à gauche (ALIGN=LEFT) 
VALIGN  permet d'aligner le contenu : 

• en haut VALIGN = TOP 
• au centre VALIGN = MIDDLE   
• au bas VALIGN = BOTTOM  
• ou sur la même ligne VALIGN =BASELINE 

Par défaut : alignement au centre (VALIGN=MIDDLE).  
COLSPAN   donne à une cellule une largeur qui est un multiple des autres colonnes 
ROWSPAN   donne à une cellule une hauteur qui est un multiple des autres lignes 
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14.3.8  Les images  
Image simple dans une page html 
 
Syntaxe : <IMG SRC="image"> 

<IMG SRC="image"  ALIGN="attribut" height=xx width=yy> 
 
Attribut obligatoire :    SRC="image"      image = URL (adresse) de l’image à afficher 
Attributs facultatifs : 

ALIGN = "MIDDLE" aligne le texte sur le milieu de l’image 
ALIGN = "TOP" aligne le texte sur le haut de l’image 
ALIGN = "BOTTOM" aligne le texte sur le bas de l’image 
ALIGN = "LEFT" aligne l’image sur la gauche de la page 
ALIGN = "RIGHT" aligne l’image sur la droite de la page 
height=xx width=yy  impose une hauteur xx et une largeur yy de l’image en pixels. 

 
Exemple :     <IMG ALIGN=BOTTOM SRC="chouetteG.gif" height=20 width=30 > La chouette 
 

Image cliquable  
Syntaxe générale :  <a href="adresse_cible"><img SRC="adresse_image"></a> 
Exemple : 

<a href="CV-anglais.html"><img SRC="drapeau.jpg" height=68 width=52></a> 
 

Image avec différentes zones cliquables 
Syntaxe générale : 

<MAP NAME="sectionmap"> 
<AREA SHAPE="forme" COORDS="x1,x2,X3,X4" HREF="adresse_cible1"> 
<AREA SHAPE="forme" COORDS="y1,y2,y3,y4" HREF="adresse_cible2"> 
….. 
</MAP> 
<IMG SRC="adresse_image" USEMAP="#sectionmap"> 

 
où “forme” est la forme (rect, …) de la zone cliquable, x1,x2,X3,X4 les coordonnées en pixels des points 
diagonaux de cette forme.  
 
Exemple : 

<MAP NAME="sectionmap"> 
  <AREA SHAPE="rect" COORDS="37,127,154,151" HREF="phil_Web/mona.html"> 
  <AREA SHAPE="rect" COORDS="59,97,227,121" HREF="phil_Web/neuf.html"> 
  <AREA SHAPE="rect" COORDS="67,68,218,92" HREF="phil_Web/const.html"> 
  <AREA SHAPE="rect" COORDS="53,38,215,63" HREF="calepin/frames.html"> 
</MAP> 
<IMG SRC="image/front.gif" USEMAP="#sectionmap"> 

 

14.3.9  Les applets Java 
Une applet java est un programme écrit en Java, externe à la page HTML, mais téléchargé en même temps 
qu’elle. Elle est exécutée sur le poste client, et permet des applications interactives rapides telles que les 
jeux. Des paramètres peuvent être échangés entre la page HTML et l'applet. 

 
Syntaxe générale : 

<APPLET code=ProgrammeJava.class height=xx width=yy> 
     <PARAM NAME="parametre1" VALUE="valeurA"> 
     <PARAM NAME="parametre2" VALUE="valeurB"> 
  … 
</APPLET>  
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ProgrammeJava.class est le nom du programme java (applet) à faire apparaître dans la page web. 
Les attributs NAME et VALUE définissent les paramètres à échanger (parametre1, parametre2, …) 
avec leurs valeurs respectives (valeurA, valeurB, …). 
 

14.4 Les balises de l’en-tête       
Balises particulières qui sont placées dans l'en-tête du document HTML, à l’intérieur de  <HEAD> ….. 
</HEAD> 
Ces balises contiennent de l’information ou des directives qui ne sont pas affichées dans la fenêtre du 
navigateur mais qui pourront être utilisées par celui-ci. Par exemple : 

• le titre  <TITLE> 
• de l’information décrivant le contenu du document <META …> 
• lien avec une feuille de style  <LINK …> 
• fonctions avancées programmées en javascript (ou un autre langage) <SCRIPT … > 

 
- la balise <TITLE> : permet d’afficher un titre, non pas dans la page web elle-même, mais dans la barre de 
titre, au-dessus de la page web. 
 
- balises <META> : fournissent de l’information sur la page, qui n’est pas affichée. 
Exemple :  
<META NAME="author" CONTENT="toto@ujf-grenoble.fr (Toto)"> 
 
- la balise <LINK …> : fait le lien entre le contenu (texte de la page web) et la forme (consignes de 
présentation dans un fichier css) 
Syntaxe :    <LINK rel="StyleSheet" href="style1.css" type="text/css">  
rel="StyleSheet":  utilisation d ’ une feuille de style. 
href = url du fichier contenant les consignes de style (style1.css, style2.css, etc...). 
type="text/css": langage utilisé pour la feuille de style (CSS). 
 
- la balise <SCRIPT … > permet d’étendre les possibilités du HTML en programmant des fonctions 
avancées dans un autre langage, qui est souvent du javascript. 
Exemple : 
<SCRIPT LANGUAGE="JavaScript"> 
  <!-- debut du script 
  function VersionNavigateur(Netscape, Explorer) { 
  if ((navigator.appVersion.substring(0,3) >= Netscape && 
navigator.appName == 'Netscape') ||       
      (navigator.appVersion.substring(0,3) >= Explorer && 
navigator.appName.substring(0,9) == 'Microsoft')) 
    return true; 
  else return false; 
  } 
//  fin du script --> 
</SCRIPT> 
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Exemple d’en-tête : 
 

<HEAD> 
  <TITLE>Bouton dynamique</TITLE> 
  <LINK rel="StyleSheet" href="style1.css" type="text/css"> 
  <META NAME="description" CONTENT="Guide pratique du langage HTML> 
  <META NAME="keywords" CONTENT="guide, pratique, progressif, html facile, belles
page, web, site, webexpert> 
  <META NAME="author" CONTENT="toto@ujf-grenoble.fr (Toto)"> 
  <META NAME="copyright" CONTENT="© 2002-2003 UJF">   
  <SCRIPT LANGUAGE="Javascript"> 
   <!-- debut du script 
    function VersionNavigateur(Netscape, Explorer) { 
     ... 
     } 
     //  fin du script --> 
  </SCRIPT> 
</HEAD> 
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15  Propriétés des styles CSS 
 
Sélection des propriétés de styles, d’après UNGI (http://guide.ungi.net/style.htm#_1_1) 
 
Nom 
propriété 

Valeur de la propriété Description Exemple 

background
-color 

color 
transparent 

couleur de fond du texte 
Par défaut : transparent 

H1 { background-color: #FF0000 } 

background
-image 

url(…) 
none 

image du fond d'écran 
Par défaut : none 

BODY { background-
image:url(ungi.gif)} 

color aqua, black, blue, fuchsia, 
gray, green, lime, maroon, 
navy, olive, purple, red, 
silver, teal, white, yellow. 
#FA6200 
rgb (10, 20, 255) 

couleur d'un texte 
par leur nom en anglais : 
RGB en valeur hexadécimale:  
Fonction RGB en valeur décimale:  
Par défaut : black 

P { color: red }  
H1 {color:rgb(255,0,0)}  
H1 { color: #FFFF00} 

Arial, Arial Black, Comic 
Sans MS, Courier New, 
Georgia, Impact, Symbol, 
Times New Roman, 
Trebuchet MS,  
Verdana, Webdings 

 
 
nom de police particulière. 
 

font-family 

Serif sans-serif cursive 
fantasy fancy monospace 

famille de police. 

BODY {font-family: Arial, helvetica, 
sans-serif } 

font-size xx-small x-small small 
medium large x-large 
xx-large 
larger smaller 
valeur  
pourcentage 

Taille de la police (pt, px, in, cm, %) 
Par défaut : medium 

P { font-size: 12pt; }  
BLOCKQUOTE {font-size: larger }  
H2 { font-size:150%}  
H2 { font-size:1.5em} 

font-style Normal 
italic  
oblique 

style normal, italique et oblique H1, H2, H3{font-style: italic } 

font-weight Light normal bold  
bolder lighter  
100 200 300 400 500 600 
700 800 900 

Epaisseur du trait des caractères 
Par défaut : normal.  

H1{font-weight:bolder } 

font font-style 
font-variant 
font-weight 
font-size  
line-height  
font-family 

Permet de regrouper les différentes 
propriétés de polices en une ligne  
Par défaut : dépend de la configuration 
du navigateur 
 

P { font: 12pt/14pt sans-serif }  
P { font: 80% sans-serif }  
P { font: x-large/110% "new century 
schoolbook", serif }  
P { font: bold italic large Palatino, serif} 
P { font: normal small-caps 
120%/120% fantasy } 

height longueur  
auto 

Hauteur du texte ou d’une image (pt, 
px, in, cm, %) 
Par défaut : auto 

IMG.icon { height: 100px } 

line-height normal  
nombre  
pourcentage 

Hauteur de l’espace entre deux lignes 
adjacentes (pt, px, in, cm, %) 
Par défaut : normal 

DIV { line-height: 1.2; font-size: 10pt } 

list-style-
type 

disc circle square  
decimal lower-roman upper-
roman lower-alpha upper-
alpha 
none 

type de puces d’une liste 
type de numérotation d’une liste  
 
Par défaut : disc 

OL { list-style-type: lower-roman }  
/* i ii iii iv v etc. */ 

list-style-
image 

url(…)  
none 

permet de remplacer les types de 
numérotation de list-style-type par une 
image 
Par défaut : none 

UL { list-style-image: url(ungi.gif) } 

margin-top longueur 
auto  
pourcentage 

valeur de la marge haute 
Par défaut : auto 

H1 { margin-top: 3px } 

margin-right longueur 
auto  
pourcentage 

valeur de la marge droite 
Par défaut : auto 

H1 { margin-rigth: 3px } 

margin-
bottom 

longueur 
auto  
pourcentage 

valeur de la marge basse 
Par défaut : auto 

H1 { margin-bottom: 3px } 

margin-left longueur valeur de la marge gauche H1 { margin-left: 3px } 
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auto  
pourcentage 

Par défaut : auto 

margin longueur 
auto  
pourcentage 

permet de regrouper les différentes 
propriétés de marge en une ligne 
Par défaut : auto 

BODY { margin: 1em 2em 3em 2em } 
 
/* top=1em, right=2em, bottom=3em, 
left=2em */ 

text-align left right center justify permet de placer le texte à gauche, à 
droite, de le centrer ou de le justifier. 

P { text-align:justify} 

text-
decoration 

none   
underline  overline 
line-through  blink  

permet de spécifier si le texte est 
souligné, surligné, barré ou clignotant 
Par défaut : none 

A:link, A:visited, A:active {text-
decoration: none } 

text-
transform 

capitalize uppercase  
lowercase none 

permet de forcer les caractères en 
majuscule (uppercase) ou en 
minuscule (lowercase); capitalize force 
en majuscule le premier caractère 

H2 { text-transform: uppercase } 

vertical-
align 

baseline sub super top  
text-top middle bottom  
text-bottom 

Spécifie l'alignement vertical du texte 
par rapport au reste du texte 
Par défaut : baseline 

P {vertical-align: sub} 

 
 
 
Exemples de balises dont on peut changer le style par défaut à l’aide des propriétés du tableau ci-dessus : 
BODY,  
H1, H2, H3, H4, H5, H6 
A,  A :link,  A :visited, A :hover 
P, DIV, BLOCKQUOTE, SPAN 
UL, OL 
TR, TD, TH 
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16  Traduction Algo / Javascript 
 

 
 Algorithme Javascript 
Commentaire {phrase en commentaire } // commentaire sur une ligne 

/* commentaire 
    sur plusieurs lignes */ 

Déclaration de variable i : entier Var i 
Affectation x ← 2 

ch ← "chaine" 
x = 2 ; 
ch = "chaine" ; 

Incrémenter une variable j ← j + 1 j ++ 
Itération (pour tout) pour i= 1 à 3 faire 

   action 
fin pour 

for(i=1; i<=3; i++) {    
   action; 
} 

Itération (tant que) j ← 3 
tant que j>0 faire 
   action1 
   action2 
   j← j-1 
Fin tant que 

j = 3 
while (j>0) { 
   action1; 
   action2; 
   j=j-1; 
} 

Instruction condition Si cond  
alors  
   action1 
sinon 
   action2 
   action3 
Fin Si 

if (cond){ 
   action1 
} 
else { 
   action2 
   action3 
} 

Condition A = B 
A > B 

A = = B 
A > B 

Opérateur +  -  x  / +  -  *  / 
Modulo 
(reste de la division 
entière) 

Mod 
Ex : A mod B 

% 
Ex : A % B 

Fonction affichage Ecrire ( … ) Document.writeln (….) 
 
 


